# CONTENTS

## CHAPTER 1 Deployment 1
- Deployment Options 1
- Requirements 1
  - System Requirements 1
  - Port Requirements 2
  - Supported Products 2
  - Supported Locales 3
  - Supported Browsers 3

## CHAPTER 2 Installation 5
- Pre-Installation Tasks for Cisco Prime License Manager 5
- Gather Information for Installation 5
- Install Virtual Machine 9
- Install Cisco Prime License Manager 9
- Remove Cisco Prime License Manager 11

## CHAPTER 3 Setup 13
- About Window 13
- Dashboard View Settings 14
- Licenses View Settings 15
- License Usage Page Settings 15
- License Planning Page Settings 17
- License Fulfillment Page Settings 18
- Product Instances View Settings 27
- Administration View Settings 30

## CHAPTER 4 Upgrade 35
- Upgrade Software Using the Cisco Prime License Manager GUI 35
Troubleshooting 69

Unknown Username and Password 69
Configuration Changes Are Not Appearing 70
The Cause of The Error Is Unknown 70
Product Instance was not Added 70
Product Instance was Deleted, but is Still Showing Up in License Usage Data 71
Product Instance Was Added and Is Not Showing Up in License Usage Data 71
License Usage Data in Product Admin GUI Does Not Match Product Instances View 71
Non-Compliance Alerts are not Appearing when License Manager Goes into Non-Compliance 72
License Manager Does Not Indicate a Product Overage 72
Licenses Are Missing Following Restoration of License Manager on a Different Server 72
Cannot Bring System into Compliance Using the Upgrade Licenses Wizard 73

APPENDIX A

Cisco Prime License Manager CLI Commands 75

Introduction 75
license file 76
license management change user name 76
license management reset user password 77
license management list users 77
license management product re-register all 78
license management reset 78
license management security update 79
license management service 79
license management set log level 79
license management set log level core_services 79
license management set log level product_instances 80
license management show log level 81
license management show log level core_services  81
license management show log level product_instances  81
license management show system  81
license management system remove  82
license client reset registration  82
license management unlock admin  82
Deployment

Deployment Options

You can deploy Cisco Prime License Manager in one of the following ways:

• Coresident deployments—Cisco Prime License Manager is installed automatically as part of the installation of Cisco Unified Communications Manager and Cisco Unity Connection. You may choose to run Cisco Prime License Manager on one of these servers in a coresident configuration. Refer to the latest release of the platform-specific installation document for more information:
  ◦ Installing Cisco Unified Communications Manager
  ◦ Installation Guide for Cisco Unity Connection
  ◦ Installing Cisco Business Edition 6000

• Standalone deployments—You need two files to install Cisco Prime License Manager:
  ◦ A virtual machine template (OVA file) is available from Software Download Center.
  ◦ An ISO file is available via electronic software download after you purchase Cisco Unified Communications Manager or Cisco Unity Connection.

Requirements

System Requirements

Here are the server requirements as defined in the virtual machine template that should be used to install a standalone instance of Cisco Prime License Manager.
## Port Requirements

The following table provides a list of ports used by Cisco Prime License Manager. If you wish to use automatic license fulfillment, Cisco Prime License Manager should be allowed direct outbound access to the Internet.

<table>
<thead>
<tr>
<th>Description</th>
<th>Protocol</th>
<th>Inbound Port</th>
<th>Outbound Port</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browser HTTP</td>
<td>TCP</td>
<td>80/8080, 443/8443</td>
<td>N/A</td>
</tr>
<tr>
<td>SSH/SFTP</td>
<td>TCP</td>
<td>22</td>
<td>N/A</td>
</tr>
<tr>
<td>Ephemeral port ranges for clients initiating connections</td>
<td>TCP, UDP</td>
<td>32768-61000</td>
<td>N/A</td>
</tr>
<tr>
<td>DNS name resolution</td>
<td>TCP, UDP</td>
<td>N/A</td>
<td>53</td>
</tr>
<tr>
<td>To connect to Product instances and to the Cisco licensing portal for e-Fulfillment</td>
<td>TCP</td>
<td>N/A</td>
<td>80, 8080, 443, 8443 (HTTP and HTTPS)</td>
</tr>
<tr>
<td>DRS</td>
<td>TCP</td>
<td>N/A</td>
<td>22 (SSH/SFTP)</td>
</tr>
<tr>
<td>DHCP client</td>
<td>UDP</td>
<td>N/A</td>
<td>67</td>
</tr>
<tr>
<td>NTP client</td>
<td>TCP, UDP</td>
<td>N/A</td>
<td>123</td>
</tr>
</tbody>
</table>

## Supported Products

Cisco Prime License Manager supports the following products:

- Cisco Unified Communications Manager
- Cisco Unity Connection
- Cisco Emergency Responder
Supported Locales

The following locales are supported for Cisco Prime License Manager:

- English (default)
- Japanese
- Chinese (simplified)
- Korean
- Chinese (traditional)
- German
- French (France)
- Italian
- Spanish (Spain)
- Spanish (Latin American) - also known as Spanish (Colombia)
- Portuguese (Brazil)
- Dutch (Netherlands)
- Russian

Supported Browsers

The following table defines Cisco Prime License Manager browser support:

<table>
<thead>
<tr>
<th>Browser</th>
<th>Browser Version</th>
<th>Windows OS</th>
<th>Apple OS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Win 8</td>
<td>Windows 7 (32 and 64 bit)</td>
</tr>
<tr>
<td>Firefox</td>
<td>45.0b10</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>FF 17-33</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Chrome</td>
<td>49.0.2623.75</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Chrome 23-24</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>Chrome 22</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td>Safari</td>
<td>Safari 9.0.3</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>Safari 6.0-6.1</td>
<td>Not supported</td>
<td>Not supported</td>
</tr>
<tr>
<td>Browser</td>
<td>Browser Version</td>
<td>Windows OS</td>
<td>Apple OS</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------</td>
<td>---------------------</td>
<td>----------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Win 8</td>
<td>Windows 10 (64 bit)</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>IE 11</td>
<td>Supported</td>
<td>Supported</td>
</tr>
<tr>
<td></td>
<td>IE 9-10</td>
<td>Supported for 64 bit</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td>IE 8</td>
<td>Not supported</td>
<td>Secondary</td>
</tr>
<tr>
<td>Edge</td>
<td>20.10240</td>
<td>N/A</td>
<td>Supported</td>
</tr>
</tbody>
</table>

**Note**

The following browsers and operating systems are not currently supported: Opera, Linux OS, Google Chrome OS.
Installation

- Pre-Installation Tasks for Cisco Prime License Manager, page 5
- Gather Information for Installation, page 5
- Install Virtual Machine, page 9
- Install Cisco Prime License Manager, page 9
- Remove Cisco Prime License Manager, page 11

Pre-Installation Tasks for Cisco Prime License Manager

Perform all pre-installation tasks to ensure that you can successfully install Cisco Prime License Manager.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Review the system requirements and ensure that the server you wish to host the application on has sufficient resources.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Create your virtual machine using the Cisco Prime License Manager Virtual Server Template (OVA file) recommended for your current release.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Verify that you have an NTP server accessible, since an NTP server is required for VMware deployments.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Ensure that the hostname and address that you plan to use for Cisco Prime License Manager are registered with the name server and that both forward and reverse lookups are possible.</td>
</tr>
</tbody>
</table>

Gather Information for Installation

Use the following table to collect information that is pertinent to your system and network configuration.
### Table 1: Server Configuration Data

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
</table>
| **Time Zone** | This field specifies the local time zone and offset from Greenwich Mean Time (GMT). Select the time zone that most closely matches the location of your machine. | Yes, you can change the entry after installation by using the following CLI command: set timezone  
To view the current time zone configuration, use the following CLI command: show timezone config |
| **MTU Size**  | The maximum transmission unit (MTU) represents the largest packet, in bytes, that this host will transmit on the network. Enter the MTU size in bytes for your network. If you are unsure of the MTU setting for your network, use the default value. Default specifies 1500 bytes. | Yes, you can change the entry after installation by using the following CLI command: set network mtu |
| **DHCP**     | Cisco Prime License Manager requires a static IP address. As a result, we recommend that you select No for the DHCP option and then enter a hostname, IP address, IP mask, and gateway. | No, you should not change the entry after installation.                        |
| **Hostname** | Enter a hostname that is unique to your server. The hostname can comprise up to 32 characters and can contain alphanumeric characters and hyphens. The first character cannot be a hyphen. | Yes, you can change the entry after installation.  
set network hostname  
**Note** Do not change your hostname while any tasks are running. |
| **IP Mask**  | Enter the IP subnet mask of this machine.                                                                                                                                                                   | Yes, you can change the entry after installation by using the following CLI command: set network ip eth0 |
### Gateway Address

<table>
<thead>
<tr>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the IP address of the network gateway. If you do not have a gateway, you must still set this field to 255.255.255.255. Not having a gateway will prevent Cisco Prime License Manager from communication outside of its subnet and will prevent the use of e-fulfillment.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>set network gateway</code></td>
</tr>
</tbody>
</table>

### DNS Enable

<table>
<thead>
<tr>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
<tbody>
<tr>
<td>A DNS server resolves a hostname into an IP address or an IP address into a hostname. Select Yes to enable DNS. This will ensure that e-fulfillment will work properly.</td>
<td>No, you should not change the entry after installation.</td>
</tr>
</tbody>
</table>

### DNS Primary

<table>
<thead>
<tr>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
</table>
| Enter the IP address of the DNS server that you want to specify as the primary DNS server. Enter the IP address in dotted decimal format as ddd.ddd.ddd.ddd. | Yes, you can change the entry after installation by using the following CLI command: `set network dns`  
To view DNS and network information, use the following CLI command: `show network eth0 detail` |

### DNS Secondary (optional)

<table>
<thead>
<tr>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the IP address of the DNS server that you want to specify as the optional secondary DNS server.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>set network dns</code></td>
</tr>
</tbody>
</table>

### Administrator ID

<table>
<thead>
<tr>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
</table>
| This field specifies the OS Administrator account username and password that you use for secure shell access to the CLI on Cisco Prime License Manager. | No, you cannot change the entry after installation.  
**Note** After installation, you can create additional Administrator accounts, but you cannot change the original Administrator account username. |
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Can Entry Be Changed After Installation?</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OS Administrator Password</strong></td>
<td>This field specifies the password for the Administrator account, which you use for secure shell access to the CLI. You also use this password with the adminsftp user. You use the adminsftp user to access local backup files, upload server licenses, and so on. For guidelines relating to strong passwords, see the corresponding password section.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>set password user admin</code></td>
</tr>
<tr>
<td><strong>Certificate Parameters</strong></td>
<td>From the list, select the appropriate organization, unit, location, and state for your installation. <strong>Note</strong> You can use this field to enter multiple organization units. To enter more than one organization unit name, separate each entry with a comma. For entries that already contain a comma, enter a backslash before the comma that is included as part of the entry.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>set web-security</code></td>
</tr>
<tr>
<td><strong>NTP Server</strong></td>
<td>Enter the hostname or IP address of one or more Network Time Protocol (NTP) servers with which you want to synchronize. You can enter up to five NTP servers. <strong>Note</strong> To avoid potential compatibility, accuracy, and network jitter problems, the external NTP servers that you specify for the primary node can be NTP v4 (version 4). If you are using IPv6 addressing, external NTP servers must be NTP v4.</td>
<td>Yes, you can change the entry after installation Yes, you can change the entry after installation <code>utils ntp server</code></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Can Entry Be Changed After Installation?</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>------------------------------------------</td>
</tr>
<tr>
<td>Security Password</td>
<td>Enter your security password. The password must contain at least six alphanumeric characters. The password can contain hyphens and underscores, but it must start with an alphanumeric character.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>set password user security</code></td>
</tr>
<tr>
<td>Cisco Prime License Manager Application Account Username</td>
<td>This field specifies the Cisco Prime License Manager application account username that you use to log on to Cisco Prime License Manager GUI.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>license management change user name</code></td>
</tr>
<tr>
<td>Cisco Prime License Manager Application Password</td>
<td>This field specifies the password for the Cisco Prime License Manager application account, which you use for secure shell access to Cisco Prime License Manager GUI.</td>
<td>Yes, you can change the entry after installation by using the following CLI command: <code>license management change user password</code></td>
</tr>
</tbody>
</table>

**Install Virtual Machine**

Use this procedure and your VMware documentation to install your virtual machine.

**Procedure**

1. **Step 1** Access the Software Download Center and download the Cisco Prime License Manager OVA template for your desired release: Downloads Home > Products > Cloud and Systems Management > Collaboration and Unified Communications Management > Cisco Prime License Manager.
2. **Step 2** From the vCenter or vSphere Client, open the console of your newly downloaded virtual machine template.
3. **Step 3** From the vCenter or vSphere Client, select File > Deploy OVF Template.
4. **Step 4** Follow the Deploy OVF Template wizard to create the Cisco Prime License Manager virtual machine. After the installation is complete, the newly installed virtual machine appears in the selected location within the vCenter or vSphere Client.

**Install Cisco Prime License Manager**

**Before You Begin**

Install virtual machine.
Procedure

**Step 1** Download the ISO installation file from Cisco electronic software delivery or locate the DVD provided with your order. Use vCenter or vSphere Client to copy the ISO image to your host datastore.

**Step 2** Using the vCenter or vSphere Client, select *Edit virtual machine settings > Network adapter 1 > MAC Address*.

**Step 3** Select the Manual option and enter a unique MAC address. For a standalone installation of Cisco Prime License Manager, only static MAC addresses are supported on the virtual machine.

**Step 4** Edit CD/DVD drive 1. Select *Connect at power on* and select the ISO installation file from where it was saved to the datastore or Host Device if using a physical DVD.

**Step 5** From the vCenter or vSphere Client, open the console of your virtual machine.

**Step 6** Power on the virtual machine. The installation begins automatically.

**Step 7** If you are using an ISO file, click *Skip* on the Disc Found screen to skip testing the media before installation. Otherwise, select the *OK* tab and press Enter to initiate testing of the media before installation. The Media Found screen appears with the following message: "Found local installation media."

**Step 8** The Product Deployment Selection screen appears. Select the product (there may only be one product available to select) and click *OK* to proceed with the installation.

**Step 9** Click *Yes*.

**Step 10** Select *Proceed* to continue with the installation.

**Step 11** Click *Continue*.

**Step 12** In the Timezone Configuration screen, select your timezone and click *OK*.

**Step 13** In the Auto Negotiation Configuration screen, click *Continue*.

**Step 14** When asked if you want to change the MTU size from the OS default, click *No* to proceed.

**Step 15** For network configuration, select *No* to set up a static network IP address for the node.

**Step 16** Enter the following static network configuration values:

- Host Name
- IP Address
- IP Mask
- GW Address

Click *OK*. Go to **Step 14**.

**Step 17** The DNS Client Configuration screen appears. To enable DNS, click *Yes*, then enter your DNS client information and click *OK*.

**Step 18** Enter your Administrator login and password information.

*Note* The Administrator login must start with an alphabetic character, be at least six characters long, and can contain alphanumeric characters, hyphens, and underscores. You will need the Administrator login to log into the command line interface.

**Step 19** The Certificate Information window displays. Enter the Certificate Information:

- Organization
- Unit
• Location
• State
• Country

Click OK to proceed.

**Step 20** The Network Time Protocol Client Configuration screen appears. Enter your NTP server information.

*Note* If DNS client was not enabled, use an IP address. If DNS is enabled, either a hostname or IP address may be entered.

Click OK to proceed.

**Step 21** When asked, enter your Security Password. Click OK to continue.

**Step 22** The Application User Configuration screen appears. Enter your username and password and log into Cisco Prime License Manager. Click OK.

**Step 23** The Platform Configuration Confirmation screen appears. Click OK to complete the configuration and start the installation.

The installation will take approximately 30 minutes to complete.

*Note* If there is an installation failure, the console will direct you to export the installation logs to a USB key, if required.

---

**Remove Cisco Prime License Manager**

In a coresident deployment, you have the option to remove Cisco Prime License Manager if it is not being used. For example, in a Cisco Unified Communications Manager cluster, Cisco Prime License Manager is installed on publisher nodes and subscriber nodes. Since the Cisco Prime License Manager only needs to be active on a single node to manage the licensing of all nodes, you may choose to remove Cisco Prime License Manager from the nodes where it is inactive.

A system reboot is required, impacting all services relating to the server. We recommend that you remove Cisco Prime License Manager during off-peak hours.

After Cisco Prime License Manager has been removed, you will continue to see a link to Cisco Prime License Manager upon login to the application, but if you try to access Cisco Prime License Manager, you are notified of the removal along with a date and time stamp.

*Caution* You cannot restore Cisco Prime License Manager after it has been removed.

**Procedure**

**Step 1** From the command line interface, enter the following command: license management system remove.

*Note* that this command is not available if Cisco Prime License Manager has already been removed.

**Step 2** Confirm that you would like to proceed with the removal by entering y.

**Step 3** Perform a system reboot.
CHAPTER 3

Setup

- About Window, page 13
- Dashboard View Settings, page 14
- Licenses View Settings, page 15
- License Usage Page Settings, page 15
- License Planning Page Settings, page 17
- License Fulfillment Page Settings, page 18
- Product Instances View Settings, page 27
- Administration View Settings, page 30

About Window

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>About</td>
<td>The About dialog box contains the Cisco Prime License Manager version number, license definition version, and Registration ID number. Note: This information can be used for re-hosting. Re-hosting is the process that customers must follow to move licenses from one instance of Cisco Prime License Manager to another. Licenses that have already been issued and fulfilled in one instance of Cisco Prime License Manager are moved to a new or different instance of Cisco Prime License Manager through the re-hosting process. As part of this process, it is suggested that the version number and Registration ID number be recorded in some fashion following any installation of Cisco Prime License Manager.</td>
</tr>
</tbody>
</table>
# Dashboard View Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Overview section</strong></td>
<td></td>
</tr>
<tr>
<td>Product Instances</td>
<td>The total number of product instances managed by Cisco Prime License Manager. Clicking Product Instances takes you to the Product Instances page.</td>
</tr>
<tr>
<td>Last License Update</td>
<td>The date of the last license update. Clicking Last License Update takes you to the Licenses &gt; License Fulfillment page.</td>
</tr>
</tbody>
</table>
| Last Synchronization   | The date of the last successful synchronization. Clicking Last Synchronization takes you to the Product Instances page where you can view the Synchronization Status and Last Successful Synchronization for each product instance. You can also perform a synchronization from this page by clicking the Synchronize Now button.  

**Note**  
Synchronization occurs when Cisco Prime License Manager collects up-to-date licensing information for all license types in the system.

| **License Alerts section** |                                                                                                                                                                                                                                                                                                                                 |
| Type                     | License types that are non-compliant                                                                                                                                                                                                                                                                                                                                                                           |
| Status                   | Provides information about the alert (for example, insufficient licenses or when a license is due to expire)                                                                                                                                                                                                                                                                                                      |

| **License Usage section** |                                                                                                                                                                                                                                                                                                                                 |
| Type                     | Specifies the product type                                                                                                                                                                                                                                                                                                                                                                           |
| Required                 | The number of licenses allocated to each of those product types                                                                                                                                                                                                                                                                                                                                                   |

| **Product Instance Alerts section** |                                                                                                                                                                                                                                                                                                                                                     |
| Name                      | Specifies the product name                                                                                                                                                                                                                                                                                                                                                                             |
| Status                    | Provides information about the product                                                                                                                                                                                                                                                                                                                                                                          |
| Last Synchronization      | The date and time of the last successful synchronization                                                                                                                                                                                                                                                                                                                                                     |
Licenses View Settings

The Licenses view contains three pages that allow you to view licensing information and configure product licenses:

- License Usage Page Settings, on page 15
- License Planning Page Settings, on page 17
- License Fulfillment Page Settings, on page 18

License Usage Page Settings

The License Usage page provides three distinct views of how licenses are being used:

- Table View
- Chart View
- History

Note

In both Table and Chart views, you have the option of synchronizing the licenses by clicking Synchronize Now.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Table View tab</strong></td>
<td></td>
</tr>
<tr>
<td>Type</td>
<td>The name of the license types supported within the product scope. For more information, click on a particular license type in the Type column to open a detailed license type page.</td>
</tr>
<tr>
<td>Product Type</td>
<td>The product type</td>
</tr>
<tr>
<td>Required</td>
<td>The number of licenses required by the product instances in order to deliver the services you have provisioned on those servers.</td>
</tr>
<tr>
<td>Installed</td>
<td>The number of licenses currently installed</td>
</tr>
<tr>
<td>Available</td>
<td>The difference between the number of Required and Installed licenses. The numbers in this column are color-coded to represent the state of unused licenses for a particular license type. If the number is red, the number of licenses is considered insufficient. If the number is black, the number of licenses is considered to be in compliance.</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Status</td>
<td>The license status (ex: “Temp Licenses Nearing Expiration”, “In Compliance”)</td>
</tr>
<tr>
<td>Synchronize Now button</td>
<td>Synchronizes Cisco Prime License Manager with the product instances to obtain the most up-to-date licensing information for all license types in the system</td>
</tr>
<tr>
<td>Chart View tab</td>
<td></td>
</tr>
<tr>
<td>License Type</td>
<td>The License Type drop down menu allows you to choose the type of license you wish to view.</td>
</tr>
<tr>
<td>Installed/Borrowed</td>
<td>The Installed/Borrowed licenses are categorized as:</td>
</tr>
<tr>
<td></td>
<td>• Installed</td>
</tr>
<tr>
<td></td>
<td>• Borrowed from Upper Tier</td>
</tr>
<tr>
<td>Important</td>
<td>Not all products support tiering</td>
</tr>
<tr>
<td>Required/Loaned</td>
<td>The Required/Loaned licenses are categorized as:</td>
</tr>
<tr>
<td></td>
<td>• Requested</td>
</tr>
<tr>
<td></td>
<td>• Loaned to Lower Tier</td>
</tr>
<tr>
<td>Note</td>
<td>Moving your mouse over the bars in the chart reveals the number of licenses installed/borrowed or required/loaned</td>
</tr>
<tr>
<td>Synchronize Now button</td>
<td>Synchronizes Cisco Prime License Manager with the product instances to obtain the most up-to-date licensing information for all license types in the system</td>
</tr>
<tr>
<td>History tab</td>
<td></td>
</tr>
<tr>
<td>History tab</td>
<td>You can download the usage history for your licenses into a csv file that can be opened in a spreadsheet application. Usage data is collected at every synchronization with product instance and with each action that changes license usage.</td>
</tr>
<tr>
<td>Date Range</td>
<td>Allows you to choose the start and end date for the period of time you wish to cover.</td>
</tr>
<tr>
<td>Product Type</td>
<td>Specifies the type of product instance</td>
</tr>
<tr>
<td>Generate File button</td>
<td>Clicking <strong>Generate File</strong> creates a usage history file for the product type chosen. A link to the file appears at the bottom of the screen. When you click on the link, you have the option of opening the file or saving it to your computer.</td>
</tr>
</tbody>
</table>
License Planning Page Settings

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Usage details page</td>
<td>Clicking on a license in the Table View in the License Usage page opens this License Usage details page.</td>
</tr>
<tr>
<td>Note</td>
<td>The License Description section provides a description of that license type. There is also a link provided to view descriptions of all license types on Cisco.com.</td>
</tr>
<tr>
<td>License Description section</td>
<td>The Usage Chart section provides a graphical representation of how many of that particular license type are available, and of those, how many are installed or borrowed from the upper tier. It also indicates how many of that license type are being used, and of those, how many are requested or loaned to the lower tier.</td>
</tr>
<tr>
<td>Usage Chart section</td>
<td>The Usage by Instance section lists the systems that are using that particular license type, and identifies the product type of the system, release version, and the number of licenses required for each of those systems.</td>
</tr>
<tr>
<td>Usage by Instance section</td>
<td>The Installed Licenses by Type section distinguishes between Permanent and Temporary licenses, the number of licenses that each is limited to, and the expiry date for the temporary licenses.</td>
</tr>
<tr>
<td>Name</td>
<td>Specifies the name of the license plan. Selecting a license plan name from the list in the History table opens the Details window for that license plan. This window contains the following information:</td>
</tr>
<tr>
<td>Description</td>
<td>Provides a brief description of the license plan.</td>
</tr>
</tbody>
</table>
### License Fulfillment Page Settings

#### Table 2: License Fulfillment Page

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Specifies the license plan type: Migration or Add</td>
</tr>
<tr>
<td>Creation Date</td>
<td>Specifies the license plan creation date</td>
</tr>
<tr>
<td>Action</td>
<td>The Action column provides a Delete button to delete a license plan</td>
</tr>
<tr>
<td>Create an Add Licenses Plan button</td>
<td>Clicking the Create an Add Licenses Plan button opens the Create an Add Licenses Plan wizard. For instructions on how to complete the Create an Add Licenses Plan wizard, see the License Planning section of this guide.</td>
</tr>
</tbody>
</table>

**Create an Add Licenses Plan page**

<table>
<thead>
<tr>
<th>Choose Product section</th>
<th>From the Choose Product section of the Create an Add Licenses Plan window, you can select (from the drop-down menus) the Product Type and the License Version to which you want to add licenses.</th>
</tr>
</thead>
</table>
| Specify License Counts section | From the Specify License Counts section of the Create an Add Licenses Plan window, you can adjust the number of licenses to be allocated to each type of license and save your changes for that license type.  
You may also choose to run a compliance check by clicking the Run Compliance Check button, or reset the license values by clicking the Reset Values button. |
| Summary and Next Steps       | From the Summary and Next Steps section of the Create an Add Licenses Plan window, you can view and save a summary of the changes you made in the Choose Product and Specify License Counts sections.  
The Save Summary in Cisco Prime License Manager option is selected by default. A default name for the summary also appears in the Name field using the format `<product-type>-add-<date-time-stamp>` format. |

### License Fulfillment Page Settings

#### Table 2: License Fulfillment Page

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable button</td>
<td>Allows you to enable e-Fulfillment. This is the default state.</td>
</tr>
</tbody>
</table>
| Disable button| Allows you to disable e-Fulfillment. If e-Fulfillment is disabled, by selecting the Disable button, only Manual Fulfillment options are visible.  
**Note** e-Migration is disabled if e-Fulfillment is disabled. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fulfill Licenses from PAK button (e-Fulfillment)</td>
<td>Opens the Add/Install Licenses wizard (e-Fulfillment)</td>
</tr>
<tr>
<td>Other Fulfillment options (e-Fulfillment)</td>
<td>Clicking the Other Fulfillment Options drop-down menu, visible when e-Fulfillment is enabled, allows you to select:</td>
</tr>
<tr>
<td></td>
<td>• Fulfill Licenses from File</td>
</tr>
<tr>
<td></td>
<td>• Generate License Request</td>
</tr>
<tr>
<td></td>
<td>• Migrate Licenses</td>
</tr>
<tr>
<td></td>
<td>• Retrieve Fulfilled Licenses</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Only the Generate License Request and Migrate License options are available under Manual fulfillment.</td>
</tr>
<tr>
<td></td>
<td>The Fulfill Licenses from File option opens the Install License File dialog box.</td>
</tr>
<tr>
<td></td>
<td>The Generate License Request option opens the License Request and Next Steps dialog box.</td>
</tr>
<tr>
<td></td>
<td>The Migrate License option opens the Migrate Licenses to Cisco Prime License Manager page.</td>
</tr>
<tr>
<td>Fulfill Licenses from File button (Manual Fulfillment)</td>
<td>Opens the Install License File page</td>
</tr>
<tr>
<td>Other Fulfillment options (Manual Fulfillment)</td>
<td>Drop-down menu, visible when e-Fulfillment is disabled, that allows you to:</td>
</tr>
<tr>
<td></td>
<td>• Generate License Request</td>
</tr>
<tr>
<td></td>
<td>• Migrate Licenses</td>
</tr>
<tr>
<td></td>
<td>The Generate License Request opens the License Request and Next Steps dialog box</td>
</tr>
<tr>
<td>Fulfillment Date</td>
<td>Specifies the date of license fulfillment</td>
</tr>
<tr>
<td>Description</td>
<td>The description, specified by the user in the wizard, of the license fulfillment</td>
</tr>
<tr>
<td>Method</td>
<td>Specifies the type of license fulfillment used (e-Fulfillment or File Install)</td>
</tr>
<tr>
<td>PAK</td>
<td>Specifies the PAK ID (in e-Fulfillment mode, the PAK IDs are clickable links that open the PAK detail window which allows you to adjust PAK fulfillment for that particular PAK)</td>
</tr>
</tbody>
</table>
### Table 3: Migrate Licenses to Cisco Prime License Manager

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose New License Version</td>
<td>From the Choose New License Version section of the Migrate Licenses to Cisco Prime License Manager window, you can select the Product Type and New License Version from the drop-down menus.</td>
</tr>
<tr>
<td>Choose Product Instances</td>
<td>From the Choose Product Instances section of the Migrate Licenses to Cisco Prime License Manager window, you can upgrade a product instance by selecting it in the Available Product Instances window and click the arrow to move it to the Product Instances to Upgrade window.</td>
</tr>
<tr>
<td>License Counts (Unified CM)</td>
<td>From the License Counts section of the Migrate Licenses to Cisco Prime License Manager window, you can view a summary of pre-upgrade product instance data. This table cannot be edited. If you selected <strong>Unified CM</strong> as your product type, the following options appear:</td>
</tr>
<tr>
<td></td>
<td>• Public Space Phones - An estimate of the number of public space phones. Public space phones do not have users assigned and are typically placed in shared workspaces, lobbies and meeting rooms. These phones generally require lower level licenses, so providing an estimate of the number of these phones in your deployment will help Cisco more accurately determine your license requirements.</td>
</tr>
<tr>
<td></td>
<td>• Case Numbers (Optional) - A case number assigned if the report was sent to Cisco Licensing Support</td>
</tr>
<tr>
<td></td>
<td>• License Usage Reports - Allows you to upload a License Usage Reports from a local drive.</td>
</tr>
<tr>
<td></td>
<td>• MAC addresses - The MAC addresses from the original servers that were upgraded. These MAC addresses can be used to look up the licenses that were registered on those product instances.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The MAC Addresses field is only displayed if pre-upgrade license usage information is not available. For more information, see Alternate Cisco Unified Communications Manager Migrations Path, on page 67.</td>
</tr>
</tbody>
</table>
### License Counts (Unity Connection)

The content of the License Counts section of the Migrate Licenses to Enterprise License Manager window depends entirely upon the options you have selected in previous sections.

If you selected **Unity Connection**, the following options appear:

- I have CUWL licenses to be migrated
- I do not have CUWL licenses to be migrated

### License Counts (standard product)

From the License Counts section of the Migrate Licenses to Cisco Prime License Manager window, you can view a table of the licenses available to migrate. This table is editable. From the table, you can reduce (but not increase) license counts in the Licenses to Migrate column. You can also run a compliance check by clicking the **Run Compliance Check** button, or reset the license values by clicking the **Reset Values** button.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Summary and Next Steps (Unified CM or Unity Connection > I have CUWL licenses to be migrated) | The content of the Summary and Next Steps section of the Migrate Licenses to Enterprise License Manager window depends entirely upon the options you have selected in previous sections. If you selected Unified CM as your product type, or Unity Connection > I have CUWL licenses to be migrated, the following options appear: In this section you must indicate how the upgrade was ordered:  
  • Upgraded using one or more service contracts  
  • Purchased the upgrade  
  If you select Upgraded using one or more service contracts, enter the UCSS/ESW Contract Numbers. If you select Purchased the upgrade, enter the Sales Order Numbers. The Cisco.com (CCO) User ID field. Company Name and the field used to capture additional information are optional. However, if you enter the company name, it is used in the subject line of the email and is included in the name of the zip file. A default name for the summary also appears in the Name field using the format <productname>-migrate-<date-time-stamp> format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click Finish & Generate Request. The License Migration Request and Next Steps window appears. Download the License Migration Request zip file to your computer. Email the License Migration Request to Cisco licensing support using the link provided. Click Close to return to the License Fulfillment page. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Summary and Next Steps (Unity Connection > I do not have CUWL licenses to be migrated) when e-Fulfillment/e-Migration is enabled | The content of the Summary and Next Steps section of the Migrate Licenses to Enterprise License Manager window depends entirely upon the options you have selected in previous sections.  
If e-Fulfillment is enabled, and you selected **Unity Connection > I do not have CUWL license to be migrated**, the following options appear: In this section, you can optionally enter a description of the e-Migration transaction.  
Read the End User License Agreement and select the checkbox to acknowledge the agreement.  
In this section, you can view and save a summary of the changes you made. To view the summary, click View Summary. A default name for the summary also appears in the Name field using the format `<productname>-migrate-<date-time-stamp>` format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click Finish & Generate Request.  
The License Migration Request and Next Steps window appears. Copy the selected text to your clipboard or click Save it to a file on your computer.  
Select License Migration Portal under Step 2 and paste the copied text in the designated field or select the saved file from your computer.  
Click Close to return to the Add or Upgrade Licenses page.  
Clicking **Finish & Generate Request** in the Summary and Next Steps section of the Migrate License Manager window initiates the e-Migration. Enter your Cisco user ID and password. The request is electronically submitted, and processed immediately. Your licenses are installed automatically. |
| Summary and Next Steps (Unity Connection > I do not have CUWL licenses to be migrated) when e-Fulfillment/e-Migration is disabled | The content of the Summary and Next Steps section of the Migrate Licenses to Enterprise License Manager window depends entirely upon the options you have selected in previous sections.  
If you selected **Unity Connection > I do not have CUWL licenses to be migrated**, the following options appear:  
In this section, you can optionally enter a description of the e-Migration transaction.  
Read the End User License Agreement and select the checkbox to acknowledge the agreement.  
In this section, you can view and save a summary of the changes you made. To view the summary, click View Summary. A default name for the summary also appears in the Name field using the format `<productname>-migrate-<date-time-stamp>` format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click Finish & Generate Request.  
The License Migration Request and Next Steps window appears. Copy the selected text to your clipboard or click Save it to a file on your computer.  
Select License Migration Portal under Step 2 and paste the copied text in the designated field or select the saved file from your computer.  
Click Close to return to the Add or Upgrade Licenses page.  
Clicking **Finish & Generate Request** in the Summary and Next Steps section of the Migrate License Manager window initiates the e-Migration. Enter your Cisco user ID and password. The request is electronically submitted, and processed immediately. Your licenses are installed automatically. |
| License Migration Request and Next Steps when e-Fulfillment/e-Migration is enabled |                                                                                                                                             |
License Fulfillment Page Settings

Setting | Description
---|---
License Migration Request and Next Steps when e-Fulfillment/e-Migration is disabled | Clicking the Finish & Generate Request button in the Summary and Next Steps section of the Migrate Licenses to Cisco Prime License Manager window opens the License Migration Request and Next Steps. You have the option of copying the selected text or clicking the Save it to a file on your computer link.

Table 4: Add/Install Licenses Wizard

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Specify PAK | From the Specify PAK section of the Fulfill Licenses from PAK wizard, you can add licenses from:  
  - A new PAK  
  - An already-installed PAK that supports partial fulfillment  
  Only PAKs that support partial fulfillment are displayed in the drop-down menu. |
| Fulfill Licenses | From the Fulfill Licenses section you can choose the licenses in the PAK that you want to fulfill.  
  The Fulfill option, under the Actions column, allows you to fulfill a particular license. Clicking the Fulfill option opens the Fulfill Licenses window. From that window, you can adjust the number of licenses you wish to fulfill for a particular license type.  
  You can also perform a compliance check of your licenses by clicking the Run Compliance Check button.  
  To reset the values you have entered, click the Reset Values button. |
| Review Contents | From the Review Contents section of the Fulfill Licenses from PAK wizard, you can review the contents of the PAK. If the PAK supports partial fulfillment, you can adjust the license installation counts. |
| Transaction Options and License Agreement | From the License Options section of the Fulfill Licenses from PAK wizard, you can add a description to the transaction or associate it with a previously generated add or upgrade plan. |

Table 5: Install License File Dialog Box

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Browse button</td>
<td>Allows you to select a license file from your computer.</td>
</tr>
</tbody>
</table>
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options</td>
<td>The Options section of the Install License File dialog box allows you to add a description and associate your transaction with a saved add/migration license summary. This step is optional.</td>
</tr>
<tr>
<td>Install button</td>
<td>When the license file has been selected (using the Browse button), it appears in the License File field. The Install button is then used to install that license file.</td>
</tr>
</tbody>
</table>

### Table 6: License Request and Next Steps Dialog Box

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy the selected text</td>
<td>The first step in the License Request and Next Steps dialog box provides the following options: copy the text in the text box to your clipboard or click the link to save the license request file to your computer.</td>
</tr>
<tr>
<td>Register your Licenses</td>
<td>The second step instructs you to register your licenses by clicking the link provided.</td>
</tr>
<tr>
<td>Install your Licenses</td>
<td>The third step advises you to return to Cisco Prime License Manager and install your licenses once you have received them. License files are generally obtained via email or downloaded from the Cisco portal. Clicking the Install button returns you to the Licenses page.</td>
</tr>
</tbody>
</table>

### Table 7: PAK Details Page

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust PAK Fulfillment option</td>
<td>Clicking the Adjust PAK Fulfillment link at the top of the PAK Details page retrieves the latest PAK details, changes the table from read-only to editable, and allows you to adjust the PAK fulfillment for Cisco Prime License Manager.</td>
</tr>
</tbody>
</table>
### PAK Contents table

The PAK Contents table contains the following columns:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SKU Name</td>
<td>specifies the name of a license contained in the file</td>
</tr>
<tr>
<td>Type</td>
<td>specifies the license type (ex: Permanent, Time-limited)</td>
</tr>
<tr>
<td>Expiration</td>
<td>specifies the expiry date of time-limited licenses</td>
</tr>
<tr>
<td>Purchased</td>
<td>specifies the total number of that license type in the PAK</td>
</tr>
</tbody>
</table>

If you select the Adjust PAK Fulfillment option, the following additional columns appear in the table:

- Before Fulfillment
  - Purchased
  - Fulfilled
  - Remaining
- Fulfill
- Remaining
- Actions

### Transaction Details

The File Details section contains the following information:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Transaction Details</td>
<td>The File Details section contains the following information:</td>
</tr>
<tr>
<td></td>
<td>• Fulfillment Date</td>
</tr>
<tr>
<td></td>
<td>• Description</td>
</tr>
<tr>
<td></td>
<td>• Associated Summary</td>
</tr>
<tr>
<td></td>
<td>• Method (File Install, e-Fulfillment, or Retrieve Fulfilled Licenses)</td>
</tr>
<tr>
<td></td>
<td>• Cisco.com Username</td>
</tr>
<tr>
<td></td>
<td>• PAK</td>
</tr>
<tr>
<td></td>
<td>• PAK Partial Fulfillment</td>
</tr>
</tbody>
</table>
Table 9: Edit Transaction Details Dialog Box

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Transaction Details</td>
<td>Clicking the Edit Transaction Details button in the View &lt;File ID&gt; window opens the Edit Transaction Details dialog box, which contains the following information:</td>
</tr>
<tr>
<td></td>
<td>• Fulfillment Date</td>
</tr>
<tr>
<td></td>
<td>• Description</td>
</tr>
<tr>
<td></td>
<td>• Associated Summary</td>
</tr>
<tr>
<td></td>
<td>• Method (File Install, e-Fulfillment, or Retrieve Fulfilled Licenses)</td>
</tr>
<tr>
<td></td>
<td>• Cisco.com Username</td>
</tr>
<tr>
<td></td>
<td>• PAK</td>
</tr>
<tr>
<td></td>
<td>• PAK Partial Fulfillment</td>
</tr>
</tbody>
</table>

The Description and Associated Summary fields can be edited.

Product Instances View Settings

The Product Instances page allows you to view product license information. From this page, you can add, delete, or synchronize product instances.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product Instances</td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Specifies the name of the product instance</td>
</tr>
<tr>
<td>Hostname/IP Address</td>
<td>Specifies the hostname or IP address of the product instance</td>
</tr>
<tr>
<td>Product Type</td>
<td>Specifies the type of product instance</td>
</tr>
</tbody>
</table>
### Setting | Description
--- | ---
Version | Specifies the product release of the product instance
Status | Specifies the status of the product instance synchronization (for example, “Success”, “Registration Conflict”, “Invalid Server Type”, “Insufficient Licenses”)
Last Successful Synchronization | Specifies the date and time of the last successful synchronization.
Add button | Clicking the Add button on the Product Instances page opens the Product Add dialog box. From this dialog box, you can enter the following information:
- Name
- Description (optional)
- Product Type
- Hostname/IP Address
- Username
- Password

*Note* | Once you have added your new product instance, be sure to click the Synchronize Now button to extract current licensing information from the product. If you do not synchronize, current product instance information may not appear in Cisco Prime License Manager.

Test Connection button | From the Product Add dialog box, you can click the Test Connection button to test the connection to the product instance prior to adding it. If the connection cannot be established, either through the connection test or by clicking OK to add a product instance, you may receive one of the following error messages:
- Instance Unreachable
- Login Failed
- Certificate Mismatch
- Registration Conflict
- Invalid Server Type
- Product Type Mismatch
- Duplicate Product Instance

*Note* | You may also skip the Test Connection button and click OK on the Add Product Instance dialog box.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete button</td>
<td>You can delete a product instance by clicking the Delete link under the Action column for the product instance.</td>
</tr>
<tr>
<td>Launch Admin GUI button</td>
<td>You can open the administration GUI for a particular product instance by selecting the check box next to the product instance and clicking Launch Admin GUI.</td>
</tr>
<tr>
<td>Synchronize Now button</td>
<td>Synchronizes Cisco Prime License Manager with the product instances to obtain the most up-to-date licensing information for all license types in the system</td>
</tr>
</tbody>
</table>

**Product Instance details page**

**Note** Clicking on a product instance in the Product Instance table opens the following details page

**General tab**

The General tab is divided into two sections:

- Product
- Administrator Account

The Product section contains the following information:

- Name
- Description
- Hostname/IP Address
- Product Type
- Product Version

The Administrator Account section contains the following fields:

- Username
- Password

Clicking the Save button saves your changes.

**Note** Prior to clicking the Save button, you have the option of clicking the Test Connection button to ensure that the connection is established.

**License Usage tab**

The License Usage tab contains a graphical representation of the license requests and a table illustrating the number of licenses requested by license type.
Administration View Settings

In a standalone deployment, the Administration view allows you to configure the following Cisco Prime License Manager settings:

- Administrator Accounts
- Backup/Restore
- Install/Upgrade
- License Definitions
- Diagnostic Logs
- Restart

A coresident deployment has similar settings but backup/restore and install/upgrade options must be configured using Cisco Unified Communications Manager:

- Administrator Accounts
- OS Administration
- Disaster Recovery
- License Definitions
- Diagnostic Logs
- Restart

For information about OS Administration or Disaster Recovery, see the Cisco Unified Communications Operating System Administration Guide or Disaster Recovery System Administration Guide for Cisco Unified Communications Manager.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrator Accounts</td>
<td>Selecting the Add Administrator button in the Administrator Accounts window opens the Add Administrator Account window. From this window, you can add an administrator account. You are prompted for the following information:</td>
</tr>
</tbody>
</table>
| Add Administrator button| • Name/Description  
|                        | • Username  
|                        | • Password  
<p>|                        | • Re-enter Password |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
</table>
| Change Password | Selecting the Change Password link in the Administrators table opens the Change Password page. From this page you can change the password of an existing administrator account. You are prompted for the following information:  
• New Password  
• Re-enter New Password |
| Backup/Restore  | The Backup Server section contains the following fields:  
• IP Address/Hostname  
• Username  
• Password  
• Directory  

The IP Address/Hostname specifies the IP Address/Hostname of the server to be backed up or restored. Enter your username and passport to connect to the server. The Directory field specifies the location of the backed up server (for example: /ws/user1-rcd/backup2)  
The Backup/Restore page also indicates when the last backup was performed.  

Run Backup button  
The Run Backup button initiates a backup of the server specified in the IP Address/Hostname field. |
| Run Restore button  
The Run Restore button initiates a restore of the server specified in the Directory field. |
| Test Connection  
The Test Connection button allows you to test the connection to the product instance prior to performing a backup or restore. |
| Install/Upgrade  | Use this page to upgrade your Cisco Prime License Manager software or to add options such as language packs to your system. |
| System Software  | Lists the active and inactive system software versions |
Clicking on the Install/Upgrade Software button opens the Install/Upgrade Software wizard. This is a two-step wizard:

1. Specify File Location
2. Select File

The Specify File Location page provides two options:

- Install/Upgrade from Network
- Install/Upgrade from DVD/CD drive on Cisco Prime License Manager server

The Install/Upgrade from Network option requires the following information:

- IP Address/Hostname
- Username
- Password
- Directory
- Transfer Protocol

The IP Address/Hostname field specifies the location of the file to be installed or used for the upgrade. Enter your username and password to connect to the server. The Directory field specifies the location where the install or upgrade will be saved.

The Transfer Protocol specifies the method: SFTP or FTP

All valid upgrades are listed in the table. Select the appropriate (valid) upgrade file from the list and click the Start Installation/Upgrade button to begin the upgrade.

### License Definitions

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>License Definitions</td>
<td>The License Definitions page contains information about the license types managed by Cisco Prime License Manager. The License Definition file should be updated prior to upgrading any of your product instances to a new version or before adding a product instance of a new type.</td>
</tr>
<tr>
<td>Check for Latest Version</td>
<td>Clicking Check for Latest Version opens the Cisco Prime License Manager Dashboard, which provides an overview of the license types currently in use.</td>
</tr>
</tbody>
</table>
| View Release Notes | Clicking View Release Notes opens the License Definitions Release Notes page, which lists:  
  - Changes Since Previous Version  
  - Supported Products |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install New License Definition File button</td>
<td>Clicking the Install New License Definition File button opens the Install License Definitions window. Click the Browse button to locate the License Definitions File and then click Fulfill to install the file.</td>
</tr>
<tr>
<td>Diagnostic Logs</td>
<td>The Log Settings tab lists the diagnostics categories and log levels. The diagnostic categories include:</td>
</tr>
<tr>
<td></td>
<td>• Cisco Prime License Manager core services</td>
</tr>
<tr>
<td></td>
<td>• Communication with product instances</td>
</tr>
<tr>
<td></td>
<td>The Log Level drop-down list for each diagnostic category can be set to one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Error</td>
</tr>
<tr>
<td></td>
<td>• Warning</td>
</tr>
<tr>
<td></td>
<td>• Info</td>
</tr>
<tr>
<td></td>
<td>• Debug</td>
</tr>
<tr>
<td></td>
<td>Once the log level has been set for each diagnostic category, you can save your changes by clicking the Save button. You may also opt to reset your log settings by clicking the Reset button.</td>
</tr>
<tr>
<td>Download Logs tab</td>
<td>The Download Logs tab allows you to generate a log file, using the date and time range of your choice to include in the log file. The default range is from 12 AM of the current day until the current time. You can then generate the file by clicking the Generate Log File button. The log file is generated and downloaded to your computer.</td>
</tr>
<tr>
<td>Restart</td>
<td>Pressing the Restart button below restarts all Cisco Prime License Manager services. This generally takes less than a minute and you will automatically be taken to the login screen when the restart is complete.</td>
</tr>
</tbody>
</table>
Upgrade

- Upgrade Software Using the Cisco Prime License Manager GUI, page 35
- Upgrade Software Using the Cisco Prime License Manager CLI, page 36
- Post-Upgrade Tasks, page 39

Upgrade Software Using the Cisco Prime License Manager GUI

You can upgrade software or apply a patch using a COP file. Use one of the following options to upgrade software using the Cisco Prime License Manager GUI:

- Upgrade from a remote file system
- Upgrade from a local source

Upgrade from a Remote File System

To upgrade the software from an FTP or SFTP server, use the following procedure.

Before You Begin

Copy the application ISO file to an FTP server that is accessible from Cisco Prime License Manager.

Procedure

Step 1  From the Cisco Prime License Manager main menu, select Administration > Install/Upgrade. The Install/Upgrade page opens.

Step 2  Click Install/Upgrade Software. The Install/Upgrade Software dialog box opens.

Step 3  Click Install/Upgrade from Network (this option should be selected by default). Enter following information:

- IP Address/Hostname
Upgrade from a Local Source

Before You Begin
Define the media source of the virtual machine. For example, is it an ISO file in the datastore or a physical optical drive on the client or host. Check the Connected checkbox for the VM CD/DVD drive.

Procedure

Step 1 From the Cisco Prime License Manager main menu, select Administration > Install/Upgrade.
Step 2 Click Install/Upgrade Software.
Step 3 Click Install/Upgrade from DVD/CD drive on Cisco Prime License Manager server.
Step 4 All valid upgrades are listed in the table. Select the appropriate (valid) upgrade file from the list.
Step 5 Click Start Installation/Upgrade.
Step 6 Click Continue to begin the upgrade.

Note You can either leave the screen up while the upgrade is in progress or close your browser. Closing your browser does not impact the upgrade process. The upgrade may take 45 minutes to an hour to complete.

Upgrade Software Using the Cisco Prime License Manager CLI

You can upgrade software or apply a patch using a COP file. To initiate an upgrade from a local or remote source using CLI commands, use the following procedures.
Upgrade from Remote Source

To upgrade the software from an FTP server, use the following procedure. Keep in mind that this procedure uses example software versions. For the latest software version, see the appropriate Release Notes for Cisco Prime License Manager.

Before You Begin
You need to place the ISO on a network location or remote drive that is accessible from Cisco Prime License Manager prior to starting this procedure.

Procedure

**Step 1** Enter the `utils system upgrade initiate` command, as shown in the following example.

**Example:**
```
admin:utils system upgrade initiate
```

The following options appear:

```
Warning: Do not close this window without first canceling the upgrade.
```

**Source:**

1) Remote Filesystem via SFTP
2) Remote Filesystem via FTP
3) Local DVD/CD
q) quit

Please select an option (1 - 3 or "q"): 

**Step 2** Select either option 1 or 2.

**Step 3** Enter Directory, Server, User Name, and Password information when prompted.

```
Directory: /software/PLM/10.0.0.98030-1
Server: ftp.mycompany.com
User Name: bsmith
Password: ********
```

Checking for valid upgrades. Please wait...

**Step 4** Enter SMTP Host Server (optional) to receive email notification once upgrade is complete.

The following options appear:

```
Available options and upgrades in "se032c-94-61:/software/PLM/10.0.0.98030-1":
```

1) CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso
q) quit

**Step 5** Select option 1 to download upgrade file.

```
Accessing the file. Please wait...
Validating the file...
Downloaded 935 MB.
```
Checksumming the file...
A system reboot is required when the upgrade process completes or is canceled. This will ensure services affected by the upgrade process are functioning properly.
Downloaded: CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso
File version: 10.0.0.98030-1

**Step 6**  When asked to automatically switch versions if the upgrade is successful, enter yes.
Automatically switch versions if the upgrade is successful (yes/no): yes

**Step 7**  Enter yes to start installation.
Start installation (yes/no): yes

---

**Upgrade from Local Source**

To upgrade the software from an FTP server, use the following procedure. Keep in mind that this procedure uses example software versions. For the latest software version, see the appropriate Release Notes for Cisco Prime License Manager.

**Before You Begin**

Define the media source of the virtual machine. For example, is it an ISO file in the datastore or a physical optical drive on the client or host. Check the Connected checkbox for the VM CD/DVD drive.

**Procedure**

**Step 1**  Insert the new DVD into the disc drive on the local server that is to be upgraded.

**Step 2**  Enter the `utils system upgrade initiate` command, as shown in the following example.

**Example:**
```
admin:utils system upgrade initiate
The following options appear:
Warning: Do not close this window without first canceling the upgrade.
Source:
1) Remote Filesystem via SFTP
2) Remote Filesystem via FTP
3) Local DVD/CD
q) quit
Please select an option (1 - 3 or "q"):
```

**Step 3**  Select option 3.

**Step 4**  Select option 1 to download upgrade file.
Accessing the file. Please wait...
Validating the file...
Downloaded 935 MB.
Checksumming the file...
A system reboot is required when the upgrade process completes or is canceled. This will ensure services affected by the upgrade process are functioning properly.
Downloaded: CiscoPrimeLM_64bitLnx_10.0.0.98030-1.sgn.iso
File version: 10.0.0.98030-1

**Step 5**  When asked to automatically switch versions if the upgrade is successful, enter yes.
Automatically switch versions if the upgrade is successful (yes/no): yes

**Step 6**  Enter yes to start installation.
Start installation (yes/no): yes

---

**Post-Upgrade Tasks**

After the upgrade, perform the following tasks:

- Check the version number in the About box to verify that it is the expected upgraded version.
- Perform a synchronization by selecting **Product Instances > Synchronize Now**.
- Check the Dashboard to verify that there are no alerts and then run a backup by selecting **Administration > Backup/Restore**.
Upgrade

Post-Upgrade Tasks
Log in

To log into a standalone Cisco Prime License Manager, enter your username and password. Click **Login**.

For coresident configurations, use the following procedure to log in:

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Step 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Cisco Prime License Manager from the list of installed applications.</td>
<td>Enter your username and password. Click <strong>Login</strong>.</td>
</tr>
<tr>
<td>The initial login requires the application username and password that you created as part of the installation. If you are not sure what username and password to use for signing into Cisco Prime License Manager, see <strong>Troubleshooting</strong>, on page 69.</td>
<td>The &quot;Getting Started&quot; window appears.</td>
</tr>
</tbody>
</table>
Initial Configuration

Follow these steps to begin using Cisco Prime License Manager:

- Add a product instance. See Add Product Instance, on page 42.

Add Product Instance

The following procedure describes how to add a product instance in Cisco Prime License Manager.

Before You Begin

Before you upgrade your system, make sure that the older version of the product instance has all of the purchased licenses installed prior to upgrading to a newer version. This will ensure that those licenses are eligible for migration.

Before adding a Cisco Unified Communications Manager instance to Cisco Prime License manager, make sure that the accountlocking setting is disabled. This will help to avoid a 401 error when you attempt to add the product instance. Check the status of the account using the following command: show accountlocking.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Log in to Cisco Prime License Manager using the application username and password that you created when you completed the installation.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Select Product Instances.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click Add. The Product Add dialog box appears.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Enter the following information:</td>
</tr>
<tr>
<td></td>
<td>• Name</td>
</tr>
<tr>
<td></td>
<td>• Description (optional)</td>
</tr>
<tr>
<td></td>
<td>• Product Type</td>
</tr>
<tr>
<td></td>
<td>• Hostname/IP Address</td>
</tr>
<tr>
<td></td>
<td>• Username</td>
</tr>
<tr>
<td></td>
<td>• Password</td>
</tr>
</tbody>
</table>

Note Credentials are the OS Administration username and password of the product.

| Step 5   | Click OK to add the product instance.                                                                                           |
| Step 6   | Once the product instance has been successfully added, the product appears in the Product Instances table.                    |

Note On the Product Instances page, click Synchronize Now to request the licensing information from the new product. If you do not synchronize, current product instance information will not appear in Cisco Prime License Manager until the next scheduled synchronization is completed.
"Contains Migratable Licenses" appears in the Status field for all product instances whose licenses have not yet been migrated to Cisco Prime License Manager. To make any licenses that are installable at the product instance available in the Cisco Prime License Manager, they must be migrated. For information about migrating licenses, see: Migrate Licenses to Cisco Prime License Manager, on page 57.

Backup/Restore

Use the following procedure to perform a backup and restore of Cisco Prime License Manager. We recommend that you perform a backup immediately before and after a successful upgrade.

Procedure

**Step 1**  From the main menu, select Administration > Backup/Restore.

**Step 2**  The Backup/Restore page opens. Enter the following information:

- IP Address/Hostname
- Username
- Password
- Directory

*Note*  At this point, you can click Test Connection to test your connection.

**Step 3**  To perform a backup, click Run Backup.

*Note*  A maximum of two backups are stored. Creating a third backup will overwrite the oldest backup.

**Step 4**  To restore, select the file you wish to restore and click Run Restore.

License Definitions

License definitions contain information about the license types managed by Cisco Prime License Manager. These definitions should be updated prior to upgrading any of your product instances to a new version or before adding a product instance of a new type. The Administration > License Definitions window provides the following information for the currently installed license definition file:

- File name
- Version
- Date Installed

You can click the Check for Latest Version link to access the Download Software site. From this site, you can locate the latest release and download it.

Once downloaded, the new license definition file can be installed using the following procedure:
Procedure

Step 1  Access the License Definitions window from the main menu by selecting Administration > License Definitions.

Step 2  Click Install New License Definition File.

Step 3  Click Browse to select the license definition file you just downloaded, then click Install.

Security Updates

Security updates may be required at Cisco Prime License Manager periodically to permit electronic operations with the Cisco License Office.

Security updates for your desired release are available from the https://software.cisco.com: Downloads Home > Products > Cloud and Systems Management > Collaboration and Unified Communications Management > Cisco Prime License Manager. You can also subscribe for alerts.

Use the following procedure to perform security updates through CLI:

Procedure

Step 1  Enter the license management security update command.

Step 2  When prompted, enter Directory, Server, User Name, and Password information, as shown in the following example:

Example:
Directory: /users/bsmith/security_update/update
Server: se032c-94-61
User Name: bsmith
Password: ********

Step 3  You are then asked to select the security update from those available in the target directory, as shown in the following example:

Example:
Available options for security update in ”se032c-94-61:/users/bsmith/security_update/update”:
1) SecUpd_v1.upd
q) quit

Step 4  Select the appropriate file from the list to download the security update. The following messages appear:
Example:
Installing security update...
Continue (y/n)?

Step 5 Enter y to continue the security update.
When the update is complete, the following message appears:
Security update installed.

Accessing Diagnostic Logs

Use the following procedure to run diagnostic logs in Cisco Prime License Manager.

Procedure

Step 1 From the main menu in Cisco Prime License Manager, select Administration > Diagnostic Logs.
Step 2 The Diagnostic Logs screen appears. Under the Log Settings tab, set the log level to Debug for both "Cisco Prime License Manager core services: and "Communication with product instances". Click Save to save your changes.
Step 3 Select the Download Logs tab and select the date and time range to include in your log file (the time period during which the issue occurred). Click Generate Log File.
Step 4 The link to the log file appears below the Generate Log File button. Click the link to download the log file to your computer and open a Service Request using the TAC Service Request Tool, https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case

Manage Product Instances

Edit a Product Instance

The following procedure describes how to edit a product instance in Cisco Prime License Manager.

Procedure

Step 1 To edit a product instance, select that instance from the Product Instances table.
Step 2 From the General tab of the Product Instance details page, edit the preferred settings for the product instance.
Important  If the hostname or IP address of the product instance changes, you need to delete the product instance from the Cisco Prime License Manager prior to changing the hostname/IP address. You then re-add it to the Cisco Prime License Manager once you have completed the hostname/IP address change.

Delete a Product Instance

Procedure

Step 1  In the Action column for the product instance you wish to delete, click Delete.
Step 2  Following a successful deletion, click Synchronize Now to obtain the most up-to-date licensing information for all license types in the system.

Administrator Account Configuration

Add Administrator Account

During installation, the first account that is created is the Master Account. The Master Account has special privileges:

• It is the only account that can create or delete administrator accounts.
• It is the only account that can modify the credential policy.

Follow the steps below to add a new administrator account.

Procedure

Step 1  Log in to Cisco Prime License Manager using the Master Account.
Step 2  From the main menu in Cisco Prime License Manager, select Administration > Administrator Accounts.
Step 3  Select Add Administrator.
Step 4  Optionally add a name or description in the Name/Description field.
Step 5  Enter a username.
Step 6  Enter and confirm your password.
  The system will evaluate the strength of the password.
Reset the Administrator or Security Password

If you lose the administrator password and cannot access your system, use this procedure to reset the password.

**Before You Begin**

- You require physical access to the node on which you perform this procedure.
- At any point, when you are requested to insert CD or DVD media, you must mount the ISO file through the vSphere client for the VMWare server. See “Adding DVD or CD Drives to a Virtual Machine” here for guidance.
- The security password on all nodes in a cluster must match. Change the security password on all machines, or the cluster nodes will not communicate.

**Procedure**

**Step 1** Sign in to the CLI on the publisher node with the following username and password:
  a) Username: pwrecovery
  b) Password: pwreset

**Step 2** Press any key to continue.

**Step 3** If you have a valid CD/DVD in the disk drive or you mounted an ISO file, remove it from the VMWare client.

**Step 4** Press any key to continue.

**Step 5** Insert a valid CD or DVD into the drive or mount the ISO file.

**Note** For this test, you must use a disk or ISO file that is data only.

**Step 6** After the system verifies the last step, you are prompted to enter one of the following options to continue:

- Enter `a` to reset the administrator password.
- Enter `s` to reset the security password.

**Note** You must reset each node in a cluster after you change its security password. Failure to reboot the nodes causes system service problems and problems with the administration windows on the subscriber nodes.

**Step 7** Enter the new password, and then reenter it to confirm.

The administrator credentials must start with an alphabetic character, be at least six characters long, and can contain alphanumeric characters, hyphens, and underscores.

**Step 8** After the system verifies the strength of the new password, the password is reset, and you are prompted to press any key to exit the password reset utility.

## User Credential Configuration Settings

The following options display when you select an administrator account from the Administrator Account list. This table describes credential settings for each user.

### Table 10: User Credential Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account Locked By Administrator</td>
<td>Check this check box to lock this account and block access for this user. Uncheck this check box to unlock the account and allow access for this user.</td>
</tr>
<tr>
<td>User Cannot Change Credentials</td>
<td>Check this check box to block this user from changing their password. You cannot check this check box when the User Must Change Credentials at Next Login check box is checked.</td>
</tr>
<tr>
<td>User Must Change Credentials at Next Login</td>
<td>Check this check box to require the user to change their password at next login. Use this option after you assign a temporary password. You cannot check this check box when the User Cannot Change Credentials check box is checked.</td>
</tr>
<tr>
<td>Credentials Do Not Expire</td>
<td>Check this check box to block the system from prompting the user to change their password. You can use this option for low-security users. If checked, the user can still change their password at any time. When the check box is unchecked, the expiration setting in the associated credential policy applies.</td>
</tr>
<tr>
<td>Reset Failed Login Attempts</td>
<td>Check this check box to reset the number of failed login attempts for this user; The Time Locked Due to Failed Login Attempts and Time of Last Login Attempt fields are automatically cleared. The number of failed login attempts increases whenever authentication fails for an incorrect credential.</td>
</tr>
<tr>
<td>Time Locked Due to Failed Login Attempts</td>
<td>This field displays the date and time that the system last locked this user account due to failed login attempts. The time gets set whenever failed login attempts equal the configured threshold in the credential policy.</td>
</tr>
<tr>
<td>Time of Last Failed Login Attempt</td>
<td>This field displays the date and time for the most recent failed login attempt for this user credential.</td>
</tr>
<tr>
<td>IP Address of Last Failed Login Attempt</td>
<td>This field displays the IP address of the user who last entered an invalid username or password.</td>
</tr>
<tr>
<td>Time Locked by Administrator</td>
<td>This field displays the date and time that the administrator locked this user account. This field is cleared after the administrator unlocks the credential.</td>
</tr>
</tbody>
</table>
**Field | Description**
--- | ---
Failed Login Attempts | This field displays the number of failed login attempts since the last successful login, since the administrator reset the failed login attempts for this user credential, or since the last reset of failed login attempts.
Time Last Changed | This field displays the date and time of the most recent password change for this user.
Last Changed by User Name | This field displays the username of the administrator who made the last password change.
Last Successful Login | This entry shows the date and time of the last successful login of a particular administrator.
IP Address of Last Successful Login | This field displays the IP address of the user who last logged in successfully.

---

## Credential Policy Configuration

### Configure the Credential Policy

The credential policy defines password requirements and account lockouts for administrator accounts in Cisco Prime License Manager. The policy contains settings for failed login resets, lockout durations, expiration periods, and password requirements. The **Credential Policy Configuration** window allows the Master Account to modify the existing credential policy for your system.

Passwords can contain any alphanumeric ASCII character and all ASCII special characters. A non-trivial password meets the following criteria:

- Must contain at least one uppercase character, one lowercase character, one number (0-9), and one special character.
- Must not contain the username.
- Must not contain only consecutive characters or numbers (for example, 654321 or ABCDEFG).

### Procedure

**Step 1**

From the main menu in Cisco Prime License Manager, select **Administration > Administrator Accounts**.

**Step 2**

Select **Credential Policy**.

**Step 3**

Modify the **Credential Policy Configuration** settings.

The system provides trivial credential checks to disallow passwords that are easily accessed. Enable trivial password checks by checking the **Check for Trivial Credentials** check box in the **Credential Policy Configuration** dialog box.
Customized Logon Message

In a co-resident deployment, a custom log-on message created for Cisco Unified Communications Manager automatically displays in the Cisco Prime License Manager logon window. You can upload a text file with your custom log-on message in the Cisco Unified OS Administration interface at Software Upgrades > Customized Logon Message.

Note

A standalone deployment does not support a custom log-on message.
License Management

- Introduction, page 51
- Create a License Plan, page 51
- Use Electronic Fulfillment to Add Licenses, page 52
- Upgrade Existing Licenses, page 53
- Other Fulfillment Options, page 55
- License Rehost, page 56
- Migrate Licenses to Cisco Prime License Manager, page 57

Introduction

Here are some of the things you can do to administer your licenses:

- Determine licensing requirements for your product. See License View Settings.
- Migrate your existing licenses if your Cisco Prime License Manager manages upgraded product instances that implement a different licensing methodology. See Migrate Licenses to Cisco Prime License Manager, on page 57.
- Perform new license fulfillment. See Create a License Plan, on page 51.

Create a License Plan

Use the following procedure to plan the addition of new licenses.
**Procedure**

**Step 1** From the Licenses > Planning window in Cisco Prime License Manager, click Create an Add Licenses Plan.

**Step 2** From the Choose Product section, select the product type and license version of the product to which you will be adding a licence. Click Next.

**Step 3** From the License Counts section, adjust the number of licenses that will be allocated to each type of license and click Save to save your changes for that license type. You may also choose to run a compliance check by clicking Run Compliance Check, or reset the license values by clicking Reset Values. After the number of licenses has been set, click Next. Clicking the arrow next to each license type reveals additional information about that license type.

**Step 4** If your compliance check fails, you can return to License Counts to make additional changes. If the compliance check passes, click Next to move to the next section.

**Step 5** In Summary and Next Steps section, you can view and save a summary of the changes you made. You can also enter your own summary name and description.

**Step 6** To view the summary, click View Summary. The Save Summary in Cisco Prime License Manager option is selected by default. A default name for the summary also appears in the Name field using the format <product-type>-add-<date-time-stamp> format. Instructions for placing your order and fulfilling your licenses also appear in this section.

**Step 7** Click Finish

**What to Do Next**

1. **Place your order**: Purchase your licenses or use your service contract to get a PAK.

2. **Fulfill your licenses**: Enter your PAK into the License Fulfillment screen of Cisco Prime License Manager and, through the e-Fulfillment process, fulfill your licenses. Cisco Prime License Manager communicates with Cisco licensing servers and your new licenses will be installed and ready to use.

---

**Use Electronic Fulfillment to Add Licenses**

Complete the following procedure to electronically fulfill your licenses.

**Before You Begin**

Create a licenses plan.

**Procedure**

**Step 1** From the Cisco Prime License Manager main menu, choose Licenses > Fulfillment.

**Step 2** In eFulfillment mode, click Fulfill Licenses from PAK.

**Step 3** Choose Add licenses from a new PAK and enter the Product Authorization Key (PAK) code.
If you have previously entered PAKs in Cisco Prime License Manager, choose **Add licenses from an already-installed PAK that supports partial fulfillment** and select the existing PAK code from the drop-down list.

**Step 4** Click Next.

**Step 5** If prompted for your Cisco.com account information, enter the username and password you entered when you registered at Cisco.com.

**Step 6** Click OK.
If there are licenses remaining to be fulfilled (and the PAK username and password are validated), the **Fulfill Licenses** section appears.

**Step 7** The licenses within the PAK are listed by SKU name. The numbers of each license are categorized under a number of headings to indicate how many have been fulfilled and how many are remaining. You can specify the number of licenses you want to fulfill by selecting **Fulfill** in the **Actions** column for that license type. The Fulfill Licenses window appears.

**Step 8** Specify the count in the **Fulfill** column, and click **Save**

**Step 9** Click **OK** to close the window.

**Important** PAKs that are not eligible for partial fulfillment are packaged together, so they can only be fulfilled at a single Cisco Prime License Manager. For example, an NFR (not-for-resale) order is sold as a package with 20 CUWL Pro Cisco Unified Communications Manager and Unity Connection licenses and five TelePresence Room licenses. The updated count now appears in the Fulfill column of the Fulfill Licenses table.

**Step 10** After you have fulfilled your licenses, you may choose to **Run Compliance Check** to ensure that you are in compliance.

**Step 11** Click **Next** to review your changes. If you are not satisfied with your changes, click **Previous** to return to the **Fulfill Licenses** section.

**Step 12** If you are satisfied with your changes, click **Next** in the Fulfill Licenses section.

**Step 13** In the **Transaction Options and License Agreement** section, enter a description (optional). You can associate this transaction with a saved license summary by selecting that option and then selecting the name of the license summary from the drop-down list.

**Step 14** Indicate that you accept the conditions of the **End User License Agreement**.

**Step 15** Click **Finish**. Upon successful completion of the e-Fulfillment process, the new fulfillment appears in the **License Fulfillment** table.

---

## Upgrade Existing Licenses

There are three types of license upgrades:

- License feature upgrades
- License version upgrades
- License feature and version upgrades
Upgrade licenses can only be used to convert currently installed licenses.

Use the following procedure to fulfill a major version upgrade using eFulfillment.

Procedure

Step 1
From the Cisco Prime License Manager main menu, select Licenses > Fulfillment.

Step 2
In eFulfillment mode, click Fulfill Licenses from PAK.

Step 3
Select Add licenses from a new PAK and enter the Product Authorization Key (PAK) code.
If you have previously entered PAKs in Cisco Prime License Manager, you can select Add licenses from an already-installed PAK that supports partial fulfillment. After you have selected that option, select the existing PAK code from the drop-down menu.

Step 4
Click Next. If prompted for your Cisco.com account information, enter the username and password you entered when you registered at Cisco.com.

Step 5
Click OK. If there are licenses remaining to be fulfilled (and the PAK username and password are validated), the Fulfill Licenses section appears.

Licenses can only be fulfilled using the cisco.com account to which they were initially issued.

Step 6
The licenses within the PAK are listed by SKU name. The numbers of each license are categorized under a number of headings to indicate how many have been fulfilled and how many are remaining.
You can specify the number of licenses you want to fulfill by selecting Fulfill in the Actions column for that license type. In the Fulfill Licenses window you can specify the license version, feature, or both, and click Save then click OK to close the window. The updated count now appears in the Fulfill column of the Fulfill Licenses table.

Note Some PAKs are not eligible for partial fulfillment. These PAKs are packaged together, so they can only be fulfilled at a single Cisco Prime License Manager in a single transaction. For example, an NFR (not-for-resale) order is sold as a package with 20 CUWL Pro Unified CM and Unity Connection licenses and five TelePresence Room licenses.

Note If licenses are listed as "Fulfilled" (under "Before Fulfillment" in the Fulfill Licenses table), those licenses have previously been fulfilled by this or another Cisco Prime License Manager.

Note Once you have fulfilled your licenses as selected, you may wish to click Run Compliance Check to ensure that you are in compliance.

Step 7
Click Next to review your changes. If you are not satisfied with your changes, click Previous to return to the Fulfill Licenses section. If you are satisfied with the changes, click Next to move to the next section.

Step 8
Click Next in the Fulfill Licenses section opens the Transaction Options and License Agreement section. In this section, you may enter a description (optional). You may also associate this transaction with a saved license summary by selecting that option and then selecting the name of the license summary from the drop-down list.

Step 9
Select the checkbox to accept the conditions of the End User License Agreement.

Step 10
Click Finish.

Upon successful completion of the e-Fulfillment process, the new fulfillment appears in the License Fulfillment table.
Other Fulfillment Options

Next to the Fulfill Licenses from the PAK option on the License Fulfillment page, there is another option entitled Other Fulfillment Options.

In Manual Fulfillment mode, selecting the drop-down arrow under this option reveals only one option: Generate License Request.

In eFulfillment mode, selecting the drop-down arrow under this option reveals three options:

- Fulfill Licenses from File
- Generate License Request
- Retrieve Fulfilled Licenses

Fulfill Licenses from File

To fulfill licenses from a file on your computer:

1. Select Other Fulfillment Options > Fulfill Licenses from File.
2. The Install License File window opens. Click the Browse button to locate the file on your computer. Select the file and click Open.
3. You can add a description and associate the transaction with a saved license plan (optional).
4. Click the Install button to install the license file.

Generate License Request

To obtain a new license (using Manual fulfillment) generate a license request through the Licenses > Fulfillment page, and then use the information generated to submit a request. You receive your license file through email. Use the following procedure to generate a license request.

1. Log in to Cisco Prime License Manager.
2. From the Licenses > Fulfillment window, select Generate License Request from the drop-down list under Other Fulfillment Options.
3. Copy the selected text to your clipboard or click Save it to a file on your PC.

Remember Once you have your license request information saved either to your clipboard or to your computer, access the Cisco License Registration site and paste it into the appropriate field. When you receive your license file through email, install your new license file in Cisco Prime License Manager using the Fulfill Licenses from File, on page 55 procedure.

Retrieve Fulfilled Licenses

The Retrieve Fulfilled Licenses option is exclusive to e-Fulfillment. This feature connects to the Cisco licensing servers to retrieve and install the licenses that have been fulfilled for this Cisco Prime License Manager. This feature is useful if you wish to synchronize your Cisco Prime License Manager with the Cisco back office regarding licenses that have been fulfilled.

Use the following procedure to retrieve fulfilled licenses:

1. Log in to Cisco Prime License Manager.
2 Select **Licenses > Fulfillment**.

3 If not already selected, click the **Enable** button to enable e-Fulfillment.

4 Under Other Fulfillment Options, select **Retrieve Fulfilled Licenses**. The Retrieve Fulfilled Licenses window appears.

5 Enter your Cisco Username and Password. You can add a description (optional) in the Transaction Description field.

6 Click the **Retrieve and Install Licenses** button.

7 Your Cisco Prime License Manager is synchronized with the Cisco back office and all licenses currently fulfilled are installed.

**License Rehost**

Licenses are fulfilled to a specific Cisco Prime License Manager. If you require licenses to be moved to a new Cisco Prime License Manager, they will be need to be rehosted. A rehost may be required if:

- A hardware failure occurred and new hardware is required for Cisco Prime License Manager
- Multiple Cisco Prime License Managers are desired and a subset of fulfillment licenses need to be moved to a new Cisco Prime License Manager

License rehosts or transfers can be requested at [www.cisco.com/go/license](http://www.cisco.com/go/license) and do not require Global Licensing Operations (GLO) support.

---

**Note**

In order to use the rehost portal, you must use the same Cisco.com user ID that initially ordered or fulfilled the licenses.

To perform a rehost, the license registration ID from the source machine as well as license request or license registration ID from the target machine is required.

Use the following procedure to perform a license rehost.
Procedure

Step 1  From Product License Registration (www.cisco.com/go/license), select Devices.
Step 2  Under the License ID tab of a particular device, select the license(s) that you want to rehost.
Step 3  In the pop-up that appears, select Rehost/Transfer.
Step 4  In the Quantity to Assign field, enter the number of licenses you want to transfer.
Step 5  In the License Request field, enter the License Request from the Cisco Prime License Manager of the target device.
Step 6  Click Next.
Step 7  In the Review screen, review your selections.
Step 8  Enter your email address, select your name from the drop-down list next to End User, and indicate that you agree with the Terms of the License.
Step 9  Click Submit.
Step 10 The rehosted license is emailed to you. It must then be manually installed on the target Cisco Prime License Manager.

Note  The license can also be downloaded to your machine by clicking Download Target on the License Request Status window and choosing the download location.

Migrate Licenses to Cisco Prime License Manager

When you upgrade a product instance from 8.x and earlier to 9.x and later, you must manually migrate your licenses. With the assistance of the Global Licensing Organization (GLO), you must convert licensing from the old paradigm to the new paradigm. For example, you can transfer licenses from Cisco Unified Communications Manager Release 8.x and older to Release 9.x and later.

This section describes the different migration paths you can follow using Cisco Prime License Manager. Cisco Emergency Responder, Cisco Unified Communications Manager, and Cisco Unity Connection each have their own migration paths.

Note  The migration path you follow depends upon a number of factors (for example: the product type, whether servers contain data from a previous version, and so on). The following flow charts provide a guide for the decisions that must be made to successfully complete your migration. For a broader view of the migration process, see the release notes for the product instance in question.

Note  If Cisco Prime License Manager is in demo mode, do not create multiple migration requests. Complete the first migration, including installation of the license, prior to initiating a second migration. If a migration request results in multiple license files, install all of them, in order, before proceeding.

Use the following procedure to plan for migration of product instances whose licenses have not yet been migrated to Cisco Prime License Manager.
Cisco Emergency Responder Migration Path

The following flow chart will aid you in migrating Cisco Emergency Responder licenses to Cisco Prime License Manager:

**Goal:** Migrate product licenses for upgraded servers in Cisco Prime License Manager

Select servers in License Migration wizard

Licenses to be Migrated dialog box opens. From the table, you can reduce (but not increase) your license counts in the Licenses to Migrate column.

Is e-Fulfillment enabled?

- **Yes**
  - Click the Finish & Generate button to generate and display a License Migration Request
  - Copy the selected text to your clipboard or save it to a file to your computer
  - The license request is passed to the licensing team. The licensing team creates a license and sends the license file by email
  - Install license file in Cisco Prime License Manager
  - License Migration Complete

- **No**
  - Click the Finish & Generate Button and enter the Cisco.com account information to initiate migration through e-Fulfillment (e-Migration)
  - The license file is automatically generated, downloaded and installed in Cisco Prime License Manager
  - License Migration Complete

---

Cisco Emergency Responder Migration Path with E-Fulfillment Enabled

The term Standard Migration refers specifically to Cisco Emergency Responder. Cisco Unified Communications Manager and Cisco Unity Connection have their own unique migration paths and are documented separately.

Use the following procedure to plan for migration of product instances whose licenses have not yet been migrated to Cisco Prime License Manager if e-Fulfillment is enabled.
Procedure

Step 1 From the Licenses > Fulfillment window in Cisco Prime License Manager, select Fulfillment Options > Migrate Licenses.

Step 2 From the Choose Product Type section, select the type of product to upgrade from the drop-down menu and click Next.

Step 3 From the New License Version section, select the version of the product to which you are migrating licenses.

Step 4 From the Available Product Instances window, select a product instance and click the arrow to move it to the Product Instances to Migrate window.
Click Next.

Step 5 From the table, you can reduce (but not increase) your license counts in the Licenses to Migrate column. You may also choose to run a compliance check by clicking Run Compliance Check, or reset the license values by clicking Reset Values. Click OK to close the dialog box and then click Next to move on to the Summary and Next Steps section.

Step 6 Specify an optional description for the transaction. Read the End User License Agreement and click Finish & Generate Request.

Step 7 Enter your Cisco user ID in the Cisco.com (CCO) User ID field.
The request is electronically submitted, and processed immediately. Your licenses are installed automatically.

Cisco Emergency Responder Migration Path with E-Fulfillment Disabled

The term StandardMigration refers specifically to Cisco Emergency Responder. Cisco Unified Communications Manager and Cisco Unity Connection have their own unique migration paths and are documented separately.

Use the following procedure to plan for migration of product instances whose licenses have not yet been migrated to Cisco Prime License Manager if e-Fulfillment is disabled.

Procedure

Step 1 From the Licenses > Fulfillment window in Cisco Prime License Manager, select Fulfillment Options > Migrate Licenses.

Step 2 From the Choose Product Type section, select the type of product to upgrade from the drop-down menu and click Next.

Step 3 From the New License Version section, select the version of the product to which you are migrating licenses.

Step 4 In the Available Product Instances window, select a product instance and click the arrow to move it to the Product Instances to Migrate window.
Click Next.

Step 5 From the table, you can reduce (but not increase) your license counts in the Licenses to Migrate column. You may also choose to run a compliance check by clicking the Run Compliance Check button, or reset the license values by clicking the Reset Values button. Click OK to close the dialog box and then click Next to move on to the Summary and Next Steps section.

Step 6 In the Summary and Next Steps section, you can view and save a summary of the changes you made. To view the summary, click View Summary. A default name for the summary also appears in the Name field using
the format <productname>-migrate-<date-time-stamp> format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click Finish & Generate Request.

**Step 7** Copy the selected text to your clipboard or click Save it to a file on your computer.

**Step 8** Select License Migration Portal under Step 2 and paste the copied text in the designated field or select the saved file from your computer.

**Step 9** Click Close to return to the License Fulfillment page.
Cisco Unified Communications Manager Migration Path

The following flow chart will aid you in migrating Cisco Unified Communications Manager licenses to Cisco Prime License Manager:

Figure 1: Cisco Unified Communications Manager Migration Flow Chart

Use the following procedure to plan for migration of all Unified Communication product instances whose licenses have not yet been migrated to Cisco Prime License Manager.
Procedure

Step 1 From the Licenses > Fulfilment window in Cisco Prime License Manager, select Fulfillment Options > Migrate Licenses.

Step 2 In the Migrate Licenses to Cisco Prime License Manager wizard, selectUnified CM from the drop-down menu in the Choose Product Type section.

Step 3 From the New License Version section, select the version of the product to which you are migrating licenses. The migration process is outlined in this section, and is dependent on the type of product you select.

Step 4 Click Next.

Step 5 To upgrade a product instance, select the product instance in the Available Product Instances window and click the arrow to move it to the Product Instances to Migrate window.

Note By default, only product instances containing license data from a previous version of Cisco Unified Communications Manager are displayed in the Available Product Instances table. If the product instance you upgraded does not appear in the list, click the Show additional Unified CM product instances check box. Selecting this check box adds product instances that contain no prior license data to the list as well as those that were included in prior license migration requests.

Step 6 Click Next.

Step 7 The Summary of Pre-Upgrade Product Instance Data table lists the product instances you selected in the previous step. This table cannot be edited. Below the table are a number of fields that require input:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>Public Space Phones</td>
<td>An estimate of the number of public space phones. Public space phones do not have users assigned and are typically placed in shared workspaces, lobbies and meeting rooms. These phones generally require lower level licenses, so providing an estimate of the number of these phones in your deployment will help Cisco more accurately determine your license requirements.</td>
</tr>
<tr>
<td>Case Numbers (Optional)</td>
<td>A case number assigned if the report was sent to Cisco Licensing Support</td>
</tr>
<tr>
<td>License Count Utility Reports (Optional)</td>
<td>Click Upload Report to open the Upload License Count Utility Report dialog box. Click Browse to select the report file and then click Upload Report.</td>
</tr>
<tr>
<td>MAC Addresses (Optional)</td>
<td>The MAC addresses from the original servers that were upgraded. These MAC addresses will be used to look up the licenses that were registered on those product instances.</td>
</tr>
</tbody>
</table>

Once you have selected the appropriate option and entered the necessary information, click Next.

Step 8 In this Summary and Next Steps section, indicate how the upgrade was ordered:

- Upgraded using one or more service contracts
- Purchased the upgrade

If you select "Upgraded using one or more service contracts", enter the UCSS/ESW Contract Numbers. If you select "Purchased the upgrade", enter the Sales Order Numbers.

Step 9 Enter your Cisco user ID in the Cisco.com (CCO) User ID field.
Company Name and the field used to capture additional information are optional. However, if you enter the company name, it is used in the subject line of the email and is included in the name of the zip file.

A default name for the summary also appears in the Name field using the format `<productname>-migrate-<date-time-stamp>` format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click Finish & Generate Request.

**Step 10** From the License Migration Request and Next Steps window, download the License Migration Request zip file to your computer.

Email the License Migration Request to Cisco licensing support using the link provided.

Click Close to return to the License Fulfillment page.
Cisco Unity Connection Migration Path

The following flow chart will aid you in migrating Cisco Unity Connection licenses to Cisco Prime License Manager:

Figure 2: Unity Connection Migration Flow Chart

Use the following procedure to plan for migration of all Unity Connection product instances whose licenses have not yet been migrated to Cisco Prime License Manager.
Procedure

Step 1  From the Licenses > Fulfillment window in Cisco Prime License Manager, select Fulfillment Options > Migrate Licenses.

Step 2  In the Migrate Licenses to Cisco Prime License Manager wizard, select Unity Connection from the drop-down menu in the Choose Product Type section.

Step 3  From the New License Version section, select the version of the product to which you are migrating licenses. The migration process is outlined in this section, and is dependent on the type of product you select.

Step 4  Click Next.

Step 5  To upgrade a product instance, select the product instance in the Available Product Instances window and click the arrow to move it to the Product Instances to Migrate window.

Step 6  Click Next.

Step 7  The License Counts section prompts you to select one of two options relating to Cisco Unified Workshop Licenses (CUWL):

<table>
<thead>
<tr>
<th>Option</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>I have CUWL licenses to be migrated</td>
<td>Click Next to move on to the Summary and Next Steps section.</td>
</tr>
<tr>
<td>I do not have CUWL licenses to be migrated.</td>
<td>You can reduce (but not increase) your license counts in the Licenses to Migrate column. You may also choose to run a compliance check by clicking Run Compliance Check, or reset the license values by clicking Reset Values. Click OK to close the dialog box and then click Next to move on to the Summary and Next Steps section.</td>
</tr>
</tbody>
</table>

Step 8  The option you selected in Step 4 determines the information displayed in the Summary and Next Steps section.
In this section you must indicate how the upgrade was ordered:
- Upgraded using one or more service contracts
- Purchased the upgrade

If you select Upgraded using one or more service contracts, enter the UCSS/ESW Contract Numbers.
If you select Purchased the upgrade, enter the Sales Order Numbers.

Enter your Cisco user ID in the **Cisco.com (CCO) User ID** field.

Company Name and the field used to capture additional information are optional. However, if you enter the company name, it is used in the subject line of the email and is included in the name of the zip file.

A default name for the summary also appears in the **Name** field using the format `<productname>-migrate-<date-time-stamp>` format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click **Finish & Generate Request**.

From the **License Migration Request and Next Steps** window, download the License Migration Request zip file to your computer.

Email the License Migration Request to Cisco licensing support using the link provided. Click **Close** to return to the License Fulfillment window.

### I have CUWL licenses to be migrated

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>I have CUWL licenses to be migrated</td>
<td>In this section you must indicate how the upgrade was ordered:</td>
</tr>
<tr>
<td></td>
<td>- Upgraded using one or more service contracts</td>
</tr>
<tr>
<td></td>
<td>- Purchased the upgrade</td>
</tr>
<tr>
<td></td>
<td>If you select Upgraded using one or more service contracts, enter the UCSS/ESW Contract Numbers.</td>
</tr>
<tr>
<td></td>
<td>If you select Purchased the upgrade, enter the Sales Order Numbers.</td>
</tr>
<tr>
<td></td>
<td>Enter your Cisco user ID in the <strong>Cisco.com (CCO) User ID</strong> field.</td>
</tr>
<tr>
<td></td>
<td>Company Name and the field used to capture additional information are optional. If you enter the company name, it is used in the subject line of the email and is included in the name of the zip file.</td>
</tr>
<tr>
<td></td>
<td>A default name for the summary also appears in the <strong>Name</strong> field using the format <code>&lt;productname&gt;-migrate-&lt;date-time-stamp&gt;</code> format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click <strong>Finish &amp; Generate Request</strong>.</td>
</tr>
<tr>
<td></td>
<td>From the <strong>License Migration Request and Next Steps</strong> window, download the License Migration Request zip file to your computer.</td>
</tr>
<tr>
<td></td>
<td>Email the License Migration Request to Cisco licensing support using the link provided.</td>
</tr>
<tr>
<td></td>
<td>Click <strong>Close</strong> to return to the License Fulfillment window.</td>
</tr>
</tbody>
</table>

### I do not have CUWL licenses to be migrated and e-Fulfillment is enabled

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Specify an optional description for the transaction. Read the end User License Agreement and select the check box to confirm.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Finish and Generate</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>Enter your Cisco.com login and click <strong>OK</strong>.</td>
</tr>
<tr>
<td>4</td>
<td>The request is electronically submitted, processed immediately, and your licenses are installed automatically.</td>
</tr>
</tbody>
</table>

### I do not have CUWL licenses to be migrated and e-Fulfillment is disabled

In this section you can view and save a summary of the changes you made. To view the summary, click **View Summary**. A default name for the summary also appears in the **Name** field using the format `<productname>-migrate-<date-time-stamp>` format. Instructions for placing your order and fulfilling your licenses also appear in this section. Click **Finish & Generate Request**.

From the **License Migration Request and Next Steps** window, copy the selected text to your clipboard or click **Save it to a file on your computer**. Select **License Migration Portal** under Step 2 and paste the copied text in the designated field or select the saved file from your computer.

Click **Close** to return to the **License Fulfillment** window.

**Note** Only e-Migration transactions are accessible on the **License Fulfillment** window. Since this is a manual migration, the migration plan is accessible only on the **License Planning** window.
Alternate Cisco Unified Communications Manager Migrations Path

The following are alternate migration paths, available for use under specific circumstances:

• Upgrades completed without the License Count Utility (LCU) Report
• Fresh install with imported pre-9.x data

Upgrades completed without LCU Report

The Cisco Prime License Manager Migration Utility relies on DLU and license usage retained during the upgrade.

In situations where a product is upgraded to 9.x, 10.x, or 11.x without running License Count Utility on a pre-9.x version. Please contact the Cisco licensing office and have the license file reissued if changes are required.

Fresh install with imported pre-9.x data

A migration may be required following a fresh install in situations where pre-9.0 DLU or license information is not available in Release 9.x, 10.x, or 11.x VM. This may occur when:

• UC Release 8.6 needs to be upgraded as a new VM, with phone data exported
• A new Release 9.x, 10.x, or 11.x VM is created, with phone data imported

The following procedure enables you to perform a migration after a fresh install. This procedure requires that an LCU report be run against pre-upgrade product instance, if still accessible, or that MAC addresses of the pre-upgrade product instances be available.

Procedure

Step 1 From the Licenses > Fulfillment window in Cisco Prime License Manager, click Fulfillment Options > Migrate Licenses.

Step 2 In the Migrate Licenses to Cisco Prime License Manager wizard, select the type of product to upgrade and the version from the drop-down menus in the Choose Product Type section. The migration process is outlined in this section, and is dependent on the type of product you select.

Step 3 Click Next.

Step 4 From the Choose Product Instances section appears, check the checkbox next to Show additional Unified CM product instances. Selecting this option allows you to view products without prior version data.

Step 5 To migrate a product instance, select it in the Available Product Instances window and click the arrow to move it to the Product Instances to Migrate window. Click Next.

Step 6 After you have read the contents of the Additional Information Will Be Required window, click Continue to close the window.

Step 7 Enter the following information in the License Counts section:

• The number of public space phones in the Public Space Phones field
• Case Numbers
• License Count Utility Reports - select the zip file using the Upload Report button
• The MAC address in the MAC Addresses field

Click Next.

**Step 8** Download the License Migration Request zip file to your computer.

**Step 9** Email the License Migration Request to Cisco licensing support using the link provided.

**Step 10** Click Close to return to the License Planning window.

---

### Licensing Migration Support

Product licensing has a grace period from the time that users are configured on the system. For Cisco Unified Communications Manager and Unity Connection, the grace period is 60 days.

The Global Licensing Operations (GLO) Team is available 24 x 7 x 365 and has knowledgeable agents that can help process your request and route it to the team best able to assist you. Expect a response within 48-72 hours.

To obtain migration support, select one of the following options:

• Open your service request through the web: [https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case](https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case)

• Open any service request through licensing@cisco.com (include Cisco.com user ID)

Troubleshooting

The following are recommended troubleshooting steps to address common issues that may occur when using Cisco Prime License Manager:

- Unknown Username and Password, page 69
- Configuration Changes Are Not Appearing, page 70
- The Cause of The Error Is Unknown, page 70
- Product Instance was not Added, page 70
- Product Instance was Deleted, but is Still Showing Up in License Usage Data, page 71
- Product Instance Was Added and Is Not Showing Up in License Usage Data, page 71
- License Usage Data in Product Admin GUI Does Not Match Product Instances View, page 71
- Non-Compliance Alerts are not Appearing when License Manager Goes into Non-Compliance, page 72
- License Manager Does Not Indicate a Product Overage, page 72
- Licenses Are Missing Following Restoration of License Manager on a Different Server, page 72
- Cannot Bring System into Compliance Using the Upgrade Licenses Wizard, page 73

Unknown Username and Password

Description
I do not know the username and password of the system when it was originally installed, so I cannot log into Cisco Prime License Manager.

Resolution
Log into the platform CLI with the OS administration credentials and use the `license management list users` command to view the username to use for signing into the Cisco Prime License Manager application. If you are not sure what the password is for this username, you can use the `license management reset user password` command to change this password.
Configuration Changes Are Not Appearing

Description
I made a configuration change in my products, but I am not seeing a change in the requested licenses reflected in Cisco Prime License Manager.

Resolution
Cisco Prime License Manager synchronizes with products every 24 hours. If you wish to see the latest configuration changes, Update Usage Details from the License Usage Report window and then select Product Instances and click Synchronize Now.

The Cause of The Error Is Unknown

Description
I received the following error message “The cause of the error is unknown”.

Resolution
Check the Cisco Prime License Manager diagnostic log for details. To access diagnostic logs, see Accessing Diagnostic Logs, on page 45.
If the cause of the error is not easily identifiable from these details, please open a Service Request using the TAC Service Request Tool, https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case. Please have your valid Cisco.com user ID and password available. As an alternative, you may also call our main Technical Assistance Center at 800-553-2447.

Product Instance was not Added

Description
I tried to add a product instance for Cisco Unified Communications Manager but received a 401 error.

Resolution
Check the status of the Cisco Unified Communications Manager account by executing the following CLI command: show accountlocking. You can only add a product instance if the account is unlocked. Disable the lock on the account using the following command: set accountlocking disable.
Product Instance was Deleted, but is Still Showing Up in License Usage Data

Description
I deleted a product instance, but I do not see it reflected in the license usage data reported on the Dashboard and Licenses > Usage.

Resolution
When a product instance is deleted from Cisco Prime License Manager, usage data is not available until the Cisco Prime License Manager synchronizes with the product instance. Synchronization happens once every 24 hours, or can be manually requested from Monitoring > License Usage using the Synchronize Now button.

Product Instance Was Added and Is Not Showing Up in License Usage Data

Description
I added a product instance, but I do not see it reflected in the license usage data in Monitoring > Dashboard and Dashboard > License Usage.

Resolution
When a product instance is added to the Cisco Prime License Manager, usage data is not available until the Cisco Prime License Manager synchronizes with the product instance. Synchronization happens once every 24 hours, or can be manually requested from Monitoring > License Usage using the Synchronize Now button.

License Usage Data in Product Admin GUI Does Not Match Product Instances View

Description
The license usage data in the administration GUI for that product (for example, when I select Product Instances > Launch Admin GUI) does not match the license usage reported at Cisco Prime License Manager in Product Instances (select Product Instance Name).

Resolution
Changes in the configuration of a product instance are not seen in the Cisco Prime License Manager until the next synchronization following the configuration change. Synchronization happens once every 24 hours. If
Non-Compliance Alerts are not Appearing when License Manager Goes into Non-Compliance

**Description**
I am not receiving any alerts when my Cisco Prime License Manager goes into non-compliance.

**Resolution**
Non-compliance alerts are generated by the product instances, not by Cisco Prime License Manager. Ensure that the product supports non-compliance alerting. If a product supports non-compliance alerting, it must be configured in the GUI for that product. For example, the administration interface in Cisco Unified Communications Manager allows you to specify which conditions are alerted and in what manner. Therefore, if you are not seeing non-compliance alerts for Cisco Unified Communications Manager, you should verify that non-compliance alerts are configured in Cisco Unified Communications Manager. If not, the alerts will be visible in the administration interface, but you will not receive those alerts via the mechanism you have selected (for example, email, SNMP, syslog).

License Manager Does Not Indicate a Product Overage

**Description**
My product says it is in overage, but my Cisco Prime License Manager does not show overage.

**Resolution**
If a product instance is unable to synchronize with its Cisco Prime License Manager, it goes into overage because it is unable to confirm that there are licenses available. Please check the last synchronization date for the product instance under Inventory > Product Instances. If synchronization is not occurring, verify that the credentials in the Cisco Prime License Manager for the product instance are accurate and that there is network connectivity between your Cisco Prime License Manager and the product instance.

Licenses Are Missing Following Restoration of License Manager on a Different Server

**Description**
I have restored my Cisco Prime License Manager on a different server and I do not have any licenses.
Resolution

When you move your Cisco Prime License Manager to a different virtual server, your licenses need to be rehosted to the new server and reinstalled. Please open a Service Request using the TAC Service Request Tool, https://tools.cisco.com/ServiceRequestTool/scm/mgmt/case, or send an email to licensing@cisco.com for next steps. Please have your valid Cisco.com user Id and password available. As an alternative, you may also call our main Technical Assistance Center at 800-553-2447.

Cannot Bring System into Compliance Using the Upgrade Licenses Wizard

Description

In the Licenses > Planning > Create an Add Licenses Plan wizard, I am unable to bring the system into compliance.

Resolution

If, across all the product instances managed by your Cisco Prime License Manager, you are using more licenses than are already installed combined with those available from the product instances you are upgrading, you will not have sufficient licenses to upgrade to bring your Cisco Prime License Manager into compliance. You will need to purchase additional licenses to cover your needs, or reduce the number of licenses required by your product instances by changing their configuration.

Note

From the License Counts window of the Create an Add Licenses Plan wizard, click Run Compliance Check to determine your license count needs. If you receive a message stating "Compliance Check Passed", you have a sufficient number of licenses and can click Next to move to the next window in the wizard. For more information, see Create a License Plan, on page 51.
Troubleshooting

Cannot Bring System into Compliance Using the Upgrade Licenses Wizard
Cisco Prime License Manager CLI Commands

- Introduction, page 75
- license file, page 76
- license management change user name, page 76
- license management reset user password, page 77
- license management list users, page 77
- license management product re-register all, page 78
- license management reset, page 78
- license management security update, page 79
- license management service, page 79
- license management set log level, page 79
- license management show log level, page 81
- license management show system, page 81
- license management system remove, page 82
- license client reset registration, page 82
- license management unlock admin, page 82

Introduction

The commands in this section are specific to Cisco Prime License Manager. For platform-specific commands, see the Command Line Interface Guide for Cisco Unified Communications Solutions.

Different command privilege levels for a user are 0, 1 and 4.
Table 11: The privilege levels definitions are as follows:

<table>
<thead>
<tr>
<th>Privilege</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Privilege level 0</td>
<td>Specifies an ordinary privilege level. Users with ordinary privileges can run CLI commands with privilege level 0 only.</td>
</tr>
<tr>
<td>Privilege level 1</td>
<td>Specifies an advanced privilege level. Users with advanced privileges can run CLI commands with privilege level 1 and below.</td>
</tr>
<tr>
<td>Privilege level 4</td>
<td>The administrator account that the system creates when Cisco Unified Communications Manager installs has a privilege level of 4. The administrator can run all commands in the CLI.</td>
</tr>
</tbody>
</table>

**license file**

This command asks to select a license file from a list.

```
license file {diagnose| get}
```

**Syntax Description**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>diagnose</td>
<td>Prints diagnostic information of the selected file.</td>
</tr>
<tr>
<td>get</td>
<td>Creates a TAR file of the license file(s) on the system and transfers the TAR file to a remote area.</td>
</tr>
</tbody>
</table>

**Command Modes**

Administrator (admin:)

**Requirements**

- Command privilege level for `diagnose`: 1 and 4
- Command privilege level for `get`: 4
- Allowed during upgrade: No
- Applies to: Enterprise License Manager, Cisco Prime License Manager

**license management change user name**

This command takes parameters interactively and changes the username of the administrator.
license management change user \{name\}

**Syntax Description**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>name</td>
<td>Specifies the administrator username.</td>
</tr>
</tbody>
</table>

**Command Modes**

Administrator (admin:)

**Requirements**

Command privilege level: 4
Allowed during upgrade: No
Applies to: Enterprise License Manager, Cisco Prime License Manager

**license management reset user password**

This command takes parameters interactively and changes the password of the administrator.

license management reset user \{password\}

**Syntax Description**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>password</td>
<td>Specifies the administrator password.</td>
</tr>
</tbody>
</table>

**Command Modes**

Administrator (admin:)

**Requirements**

Command privilege level: 4
Allowed during upgrade: No
Applies to: Cisco Prime License Manager

**license management list users**

This command lists the administrative users.

license management list users

**Command Modes**

Administrator (admin:)
license management product re-register all

This command forces re-registration of all product instances associated with this Enterprise License Manager/Cisco Prime License Manager server. This command may take some time for re-registration and synchronization with all product instances to complete.

license management product re-register all

Command Modes
Administrator (admin:)

Requirements
Command privilege level: 1 and 4
Allowed during upgrade: No
Applies to: Enterprise License Manager, Cisco Prime License Manager

license management reset

This command resets the identity, store data, and essentially removes all the installed licenses. It also restarts the Cisco Prime License Manager server process to make the changes effective.

license management reset {identity|registration}

Syntax Description

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>identity</td>
<td>Resets the identity</td>
</tr>
<tr>
<td>registration</td>
<td>Resets the registration</td>
</tr>
</tbody>
</table>

Command Modes
Administrator (admin:)

Requirements
Command privilege level: 4
Allowed during upgrade: No
Applies to: Enterprise License Manager, Cisco Prime License Manager
license management security update

This command downloads Cisco Prime License Manager security update from the specified remote server location and installs the contents of the specified security update file.

license management security update

Requirements
Command privilege level: 4
Allowed during upgrade: No
Applies to: Enterprise License Manager, Cisco Prime License Manager

license management service

This command activates or deactivates a given service on the Cisco Prime License Manager server.

license management service {activate| deactivate}

Syntax Description

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>activate</td>
<td>Activates a given service on the Cisco Prime License Manager server.</td>
</tr>
<tr>
<td>deactivate</td>
<td>Deactivates a given service on the Cisco Prime License Manager server.</td>
</tr>
</tbody>
</table>

Command Modes
Administrator (admin:)

Requirements
Command privilege level: 1 and 4
Allowed during upgrade: No
Applies to: Enterprise License Manager, Cisco Prime License Manager

license management set log level

license management set log level core_services

This command sets the log level for core services.

license management set log level core_services {error| warning| info| debug}
**Syntax Description**

<table>
<thead>
<tr>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>error</td>
<td>Provides runtime errors or unexpected conditions that could be critical.</td>
</tr>
<tr>
<td>warning</td>
<td>Provides messages about potential problems.</td>
</tr>
<tr>
<td>info</td>
<td>Provides general information that may be useful. This parameter is set by default.</td>
</tr>
<tr>
<td>debug</td>
<td>Provides detailed information about the flow of the process. We recommend that you use set this parameter on an as needed basis only.</td>
</tr>
</tbody>
</table>

**Command Modes**

Administrator (admin:)

**Requirements**

Command privilege level: 0, 1, and 4

Allowed during upgrade: No

Applies to: Cisco Prime License Manager.

**license management set log level product_instances**

This command sets the log level for product instances.

`license management set log level product_instances {error| warning| info| debug}`

**Command Modes**

Administrator (admin:)

**Requirements**

Command privilege level: 0, 1, and 4

Allowed during upgrade: No
license management show log level

license management show log level core_services

This command displays the current log level for core services.

license management show log level core_services

Command Modes

Administrator (admin:)

Requirements

Command privilege level: 0
Allowed during upgrade: No
Applies to: Cisco Prime License Manager.

license management show log level product_instances

This command displays the current log level for product instances.

license management show log level product_instances

Command Modes

Administrator (admin:)

Requirements

Command privilege level: 0, 1, and 4
Allowed during upgrade: No
Applies to: Cisco Prime License Manager.

license management show system

This command lists the administrative users.

license management show system

Command Modes

Administrator (admin:)

Applies to: Cisco Prime License Manager.
license management system remove

This command allows you to remove an unused Cisco Prime License Manager instance from a coresident deployment.

Command Modes
Administrator (admin:)

Requirements
Command privilege level: 1 and 4
Allowed during upgrade: No
Applies to: Enterprise License Manager, Cisco Prime License Manager

license client reset registration

This command resets the license client registration state to unregistered.

Command Modes
Administrator (admin)

Requirements
Command privilege level: 1 and 4
Allowed during upgrade: No
Applies to: Cisco Prime License Manager

license management unlock admin

This command unlocks a Cisco Prime Licence Manager server defined user. The command will prompt for the name of the user to unlock.

Command Modes
Administrator (admin:)

Requirements
Command privilege level: 1 and 4
Allowed during upgrade: No
Applies to: Cisco Prime License Manager
license management unlock admin